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Content Build and Migration Process

As part of the Block Learning initiative, the As-Is content for each Rating is converted from NAVEDTRAs
130 and 131 structure to a (NAVEDTRA 136) Authoring Instructional Materials (AIM) Content Planning
Module (CPM) and Learning Object (LO) Module structure. In addition to migrating the content, it will be
rolled up into a performance-based Course structure and linked to Block Learning Courses. The figure
below outlines the main touch points for the content build process and the Learning Center reviews of
each touch point.

Performance- Learning Center
Based Course Review of Implementation of Learning Center
Structure Build and Performance- Learning Center Verification of
Migration of Based Course Recommendations Course Content
Content Structure and Gaps

Learning Center .
Block Course . . Course Import into
Review of New

Development Citrix Servers
P Block Courseware

The first main touch point includes the entry of the performance-based Course structure into CPM and
the migration of the content into LO Module. Once complete, the Learning Center reviews the PDF
exports of the Lesson Plan (LP) and Trainee Guide (TG) from LO Module. During this review, the Learning
Center evaluates the migration of the content to ensure their Courses are in-tact and identifies any gaps
that may be apparent from the content migration into LO Module. The Learning Center will evaluate and
provide recommendations that contractor will implement and adjudicate.

After the Learning Center review comments are implemented, the Learning Center completes another
review of the LP and TG to ensure the implemented content complies with the needs of the Course.
Once any additional comments are implemented and verified from the Learning Center review, Blocked
Courses are created according to the Training Paths and Blocks of Training identified in the Block
Learning Recommendations Report, then the appropriate content is linked into the Blocked Courses.

The Learning Center completes a final review of the Courses, and final adjustments are made prior to
exporting the Courses from a standalone version of LO Module and importing into the Sailor 2025 Citrix
Server LO Module instance.
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1 Performance-Based Course Structure Build and Content Migration

1.1 Content Build Pre-Meeting
A pre-meeting is held with the Learning Center LSO and the Lead Contractor ISD to review the initial
content build and migration process. The goal of this meeting is to accomplish the following:

e Ensure all content is received, up to date, and has not changed since the last Training Situation
Document (TSD).
e Explain the overall content build process.
0 Discuss the NAVEDTRA 130/131 Course constructs versus AIM CPM/LO Module
(NAVEDTRA 136) Course construct.
0 Clarify the review and approval process at each touch point.
O Review and approve performance Objectives.
e Discuss future travel requirements.

1.2 Enter Performance-based Course Structure in CPM

A new Module, Lesson, and Section structure has been created in the JDTA-LO-Crosswalk-BlockLearn tab
of the RATS. The main content types, performance-items within the content, and knowledge of the main
jobs that are performed within that Rating were used to create a new organization of Lessons that have

performance-based Terminal Learning Objectives (TLOs). Sections have been appropriately grouped and
merged within each Lesson to satisfy the performance-based TLO.

Within the Content Build Process, the performance-based Course structure that was created in the RATS
is entered into CPM. In CPM, a Project is created for each Rating. Within that Project, a Module is
created for each Course within the Rating. The Lessons and Sections are created based on the approved
performance-based Course structure outlined in the RATS or the Rating Course Content Traceability
Document (Rating CCTD). After the initial migration of the content into the performance-based Course
structure, the Module titles are changed to their appropriate Family Group titles. This allows the content
to be entered into LO Module while final Objectives and Module titles are being created and entered
into CPM. If the Objectives and Module titles are previously created and approved, they may be entered
from the start of the Performance-Based Course Structure Build. Once all of the content migrated and
finalized for the Rating, the appropriate content is linked to the Block Learning Courses.

Note: Linking the content to Courses (Blocks) is not a feature currently available in CPM, but it will be
added in the near future.

1.2.1 JDTA - LO - Course Constructs

The As-Is Course content is typically structured differently than the CPM/LO Module Course structure.
Courses may look considerably different, depending on the version of the AIM software previously used
to create them. The following table aligns the JDTA, LO Module, AIM |, and AIM Il constructs to compare
the differences among them.
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JDTA LO Module
Construct

Learning Course Learning Course Learning Course
Objectives Structure | Objectives Structure Objectives Structure

Job Course Course Course Level Course Course Course
Mission Learning Mission
Statement Objectives Statement

Duty N/A Module N/A Part N/A N/A

(Family)

Task TLO Lesson N/A Section TO Unit

Subtask ELO Section N/A Topic TO Lesson

Topics

N/A Element EO Elements EO Elements
(KSATRs)

1.2.2 Performance-Based Course Structure

During the Rating Analysis, the structure of the As-Is Course is converted to the structure of CPM/LO
Module, and the content is rolled-up to performance-based Objectives. This will often change the title of
the Lessons and Sections from the As-Is Course structure and group the As-Is content differently to
satisfy the performance-based Objectives.

The performance-based Course structure is noted in the Rating CCTD. The Rating CCTD is developed
along with the Block Learning Recommendation Report from the RATS, which is sent to the Learning
Center for approval. The Rating CCTD spreadsheet aligns the current Course structure to the
performance-based Course structure and the new Block Recommendations. As seen in the image below,
Column B indicates the Topic # from the As-Is Course structure and Column C indicates the Topic title
from the As-Is Course structure. Column D indicates the performance-based Lesson titles/Objectives,
and Column E indicates the performance-based Section titles/Objectives. Column F represents the initial
Block Recommendations from the Rating Analysis, and Column G represents the final Block
Recommendations from the Learning Center.

In the following example, the Pre-Test Module 8C and Lesson Topic 1.1 are deleted. This is indicated by
Columns D and E being empty and Column F noting that the Topics are deleted. This example from
Engineman (EN) ‘A’ School indicates that Lesson Topics 1.2 — 2.2 will be in the same Lesson, titled “Diesel
Engines”. Within this Lesson, there are 5 Sections:
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e Lesson Topics 1.2 — 1.4 are merged into a Section title “Diesel Engine Components”.
0 Note: This title is extracted by removing the verb, Locate, from the entry in Column E
and title-casing each word for the title. If the entry does not have a verb, you will simply

title-case the entry to use as the Section title.
e Lesson Topic 1.5 is in a Section titled “Diesel Engine Cycles”.
e Lesson Topic 1.6 is in a Section titled “Diesel Engine Air Intake”.
e Lesson Topic 1.7 is in a Section titled “Diesel Engine Subsystems”.

e Lesson Topics 2.1 and 2.2 are merged into a Section titled “Diesel Engines Lab”.
O Note: “Lab” was added to the end of the Section title because both of the As-Is Lesson
Topics indicate that they are a lab. If one of them was not a lab, the title would remain

as “Diesel Engines”.

G a1 ® C T ] T E
NOTES:
1. Lesson Topics represent the "As-Is” lessons in the carrent Course of Instruction (COI).
2. Initial Block Recommendation of 0* indicates a good candidate for RRL, but due to Block Learn business rules, it remains in Block 0.
A. The following courses and CINs are included in this document starting on the line indicated:
EN "A’ School (A-652-0052) 164
4. To-Be Lessons and Sections are the course structure for CPM-LOM.

Line 2 |Topic # | As-Is Lesson Topic To-Be Lesson Titles/Objectives To-Be Section Titles/Objectives Initial Block Recommendation | Final Block Recommendation
(from Column J of the JDTA_to_LO- (from Column K of the JDTA 1o LO-
2 Crosswalk] CrosswalkBlockLearn)
3 EN A’ School (A-652-0052)
LT [PRE-TEST MODULE 8C Delete
5 165 | 11 |CBTBECC.DIESEL.0L, DieselEngine Delete
6 166 | 12 [Diesel Plant Indoc Safary Diesel Engine Locats diesel enzine 0
7 167 | 15 |DieselEngine Stationary. Dhesel Engine Locate diesel engine [
8 168 | 14 |DieselEngine Moving C: Diesel Engines Locate diesel engine []
9 168 13 |Diesel Engine Two and Four Stroke Cvcle Diesel Engmes DE cycles 0
0] 170 16 |Diesel Engine Aw Intake Diesel Engines Locate DE air intake 0
nm L7 |Diesel Engine Subsystems Diesel Engins Locate DE subsystems 0
12! 1m 11 |Engine Alignment and Operation (6-71), Lab Diesel Enging Operate DE 0
137 173 | 37 |Diesel Engine Cutaway. Lsb Diesel Engines Operate DE ]
LA 31 |CBTBECCDIESEL 00, Small Boat Operations Small Boats Operate small boats [
15| 173 32 |CBTBECC DIESEL 03, Small Boat Qutdnives Small Boats Operate small boats o
16 176 33 |Small Boat Operations and i Small Boats Operate small boats o
7l 34 |Owdrive Cy its and Operation Small Boats Operate small boats [
18178 | 35 |SmallBoatLab Small Boats. Operate small boats [
1.2.3 Accessing CPM

1. Insert your Common Access Card (CAC) into your CAC reader.
2. Access CPM here: https://cpm.prod.aim.netc.navy.mil/cpom2025

3. When the Confirm Certificate pop-up appears, confirm the information is correct, and then

select the OK button.

4. Inthe Windows Security pop-up, enter your CAC Personal Identification Number (PIN).
5. Select the OK button at the bottom of the DOD Notice and Consent Section.
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DOD Notice and Consent ]

You are accessing a U.5. Government (USG) Information System (IS) that Is provided
for USG-authorized use only.

By wsing this IS (which includes any device attached to this IS), you consent to the
following conditions:

The USG routinely intercepts and monitars communications on this IS for
purpeses Including, but not limited to, penetration testing, COMSEC menitoring,
network operations and defense, personnel misconduct (PM), law enforcement,
(LE), and counterintelligence (CI) investigations.

At any time, the USG may inspect and seize data stored on this IS.
Communications using, or data stored on, this IS are not private, are subject to
routine monitoring, interception, and search, and may be disclosed or used for
any USG authorized purpose.

This 1S includes security measures (e.qg., authentication and access controls) to
protect USG interests-not for your personal benefit or privacy.

Motwithstanding the above, using this IS does not constitute consent to PM, LE
or CI investigative searching or monitoring of the content of privileged
communications, or work product, related to personal representation or services
by attorneys, psychotherapists, or clergy, and their assistants, Such
communications and werk product are private and confidential. See User
Agreement for details.

Downloading data from CPM for the purpose of uploading into another
application or database other than CPM or AIM LOM is NOT AUTHORIZED. This
unauthorized use will result in immediate termination of your account and is
subject to appropriate disciplinary or legal action,

BY CLICKING "OK' THE USER ACKNOWLEDGES AND AGREES TO FOLLOW THESE
POLICIES.

User Tip: Be patient when working in CPM. CPM quite often takes a few moments to update.

Note: When exiting CPM, it is always best to select Logout. If you do not, you may have issues getting

back in.

Last logged in: 9/13/2016 12:58:00 PM

Note: Sometimes when logging back into CPM, you will get the message shown below. Select “Click here

to Login again” and proceed as normal.

You have been logged out automatically due to inactivity!

| Click here to Login again I

1.2.4 Creatinga Project
1. Select the Projects tab.
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@ https://cpm.prod.aim.netcnavy.mil/cpm2025/Home/HomeDisplay.aspx ,O - ﬂ 0 \% CPM: Cont]

‘ile Edit View Favorites Tools Help

#, CPM 2025!

Projects Reports Resources Admi

Main Events Messages Assignments My Profile

Home Data OCCSTDs JDTA

2. Select the New icon.

Projects Naval Education T V| view [§:] [New 13 |% @ I

‘ Project Title Version ]

3. Type the title of the Project into the Title* field.

Title*:

Version: 1 Status*: Incomplete v

Center*: Naval Education Training Command (NETC)
Owner*: ARNOLD, BRITTANY

Start Date: _j; End Date: |:| _TE

Scope: Course State: Active

Save Cancel !

* indicates a required field.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
Enter the full Rating title, in title case, with acronym following in parentheses.
For example, Quartermaster (QM)

Note: Do not enter a Start or End Date or change the Status* field.

4. Select the Save button.
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Title*: | 5onar Technician (Submarine) (STS)

Version: 1 Status*: | Incomplete A4 |

Center*: Naval Education Training Command (NETC)

Owner*: | ARNOLD, BRITTANY v
Scope: Course State: Active

= indicates a required field.

1.2.5 Accessing a Project
1. Access CPM.
2. Select the Projects tab.

!E {2 https//cpm.prod.aim.netcnavy.mil/cpm2025/Home/HomeDisplay.aspx L~ @& Ol @ oom: Con&

file Edit View Favorites Tools Help

CPM 2025!

EIE] OCCSTDs JDTA Projects Reports

Resources Admi

Main Events Messages Assignments My Profile

3. Select the project title from the list in the left panel.

Projects Al V] view 3 new ) Yy @

[Proiect Title Version
Aviation Electrician's Mate (AE)

CIN - Logistics Specialist (LS)

Cryptologic Technician (Maintenance) (CTM)
Logistics Specialist (LS)

Quartermaster (QM)

Sonar Technician (Submarine) (STS)

'Sonar Technician (Surface) (STG)

ol L R

4. Select the View icon to open the project.
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View & | new 13 %%=|

5. Select the +icon to expand Curriculum Development.

Home Data OCCSTDs JDTA Projects Reports Resources Admin
Main Content ToS/Assessment Info

Project Management

@4y Project Management
Curriculum Development

| E] 8 rerformance Requirements

@@ Sonar Technician (Submarine) (STS)

-- B Reports

6. Ificons do not appear in the left gray bar after you have selected the Course, have the Project
Owner add you as a member of the team.

Main Content ToS/Assessment Info

#-< Project Management

=<} Curriculum Development

~ § rerformance Requirements

; m Sonar Technician (Submarine) (STS)

~ B Reports
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User Tip: If you need to edit an existing Module, Lesson, Section, etc., select the Edit button.
New ) @ O D @Y R Ministry Support and Accomm...

ES > Project Management General Skill Basis

urriculum Development
B rerformance Requirements
@@ Religious Program Specialist (RP) - Sea - Block A Versionzlt Status?: Incompeta
&]Q Library
be

E}"$ Liturgical Appointments

= Lay Leaders

@ Religious Ministry Team

L'. Reports

Module Title*: Ministry Support and Accommodation

Delivery Method: Blended

ISD Considerations

Edit

* indicates a required field.

1.2.6 Adding a Team Member

Anyone who will be entering data into CPM for the Rating will need to be added as a team member on
the Project. If they will need to edit or enter content, they should be assigned as a Project Developer. If
they only need to view the Project, they should be assigned as View Only.

1. Access the Project.
2. Select the +icon to expand Project Management.

Home Data OCCSTDs JDTA Projects Reports Resources Admi

Main Content

Project Management

Project Management Title*: Religi
-4 Curriculum Development
@@ Reports

Version: 1

Center*: Naval

Owner*: ARNOC
Start Date:

Scope: Course
—5

* indicates a required f

3. Select Team Members.
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Project Management

[=-4» Project Management Title*: Religiou:
-ff Team Members Version: 1
i-4| Assignments Center*: Naval Ec
Change Record Owner*: ARNOLD
E!“m PP /TCCD Start Date:
#-4) Curriculum Development
Scope: Course
+- @ Reports

Edi|

* indicates a required fiel

4. Select the Edit button.

Team Members

B4 Project Management Select/unselect privilages for the project

- e ot
Project Guiner

m A ts ARNOLD, BRITTANY
3 orre
IJ;Q PR/ TCCD
B4 Curriculum Development
-0 Reports

5. From the Name column, select the name of the person to be added.

Team Members

Select/unselect privileges for the project

Name Role ~

ARNOLD, BRITTANY Project Owner

BATTLE, KEITH None

BREMER, BRUCE None

CARROLL, MARK None

CHATMAN, HALLET e

CHILDRESS, JEFFREY None

CINTRON, JOSE None

COBURN, TURKAN None =

CRANIEY, LAURA None

DANIELS, SAMANTHA lone

[DEEROUSE, BACHAFI tione

DEMARSH, RHONDA None v I

|DERKER, BETHANY Tione

HAYES, STEVEN None

HENRY, JEFFREY Mone [v
Save I Cancel

6. From the Role drop-down menu, select Project Developer or View Only, as appropriate.
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1.2.7

Team Members

Select/unselect privileges for the project

Name Role A~

ARNOLD, BRITTANY Project Owner

BATTLE, KEITH None

BREMER, BRUCE None

CARROLL, MARK None

CHATMAN, HALLET None

CHILDRESS, JEFFREY MNone

ICINTRON, JOSE None

COBURN, TURKAN None

CRANIEY, LAURA None

DANIELS, SAMANTHA None

DEBROUSE, RACHAEL None

DEMARSH, RHONDA I Project Developer v ”

DENKER, BETHANY None

HAYES, STEVEN None

HENRY, JEFFREY None v

Save Cancel

Select the Save button.

Team Members

Select/unselect privileges for the project

Name Role ~

ARNOLD, BRITTANY Project Owner

BATTLE, KEITH None

BREMER, BRUCE None

CARROLL, MARK None

CHATMAN, HALLET None

CHILDRESS, JEFFREY None

ICINTRON, JOSE None

COBURN, TURKAN None

CRANIEY, LAURA None

DANIELS, SAMANTHA MNone

DEBROUSE, RACHAEL MNone

DEMARSH, RHONDA Project Developer v l

DENKER, BETHANY MNone

HAYES, STEVEN MNone

HENRY, JEFFREY None v
conce

Adding a Module to a Course

From the Projects screen, select the appropriate project in the Project Title list, and then select

the View icon.
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Projects [My Projects v [view & new 13 % @ =

Project Title Version
Apprentice Technical Training (ATT) i
Aviation Electrician's Mate (AE)

Cryptologic Technician (Maintenance) (CTM)
Quartermaster (QM)

Sonar Technician (Submarine) (STS)

Sonar Technician (Surface) (STG)

(e (SR PEFO Y

2. Select the +icon to expand Curriculum Development.

Home Data OCCSTDs JDTA Projects Reports Resources Admin
Main Content ToS/Assessment Info

Project Management

#-<) Project Management
Curriculum Development

: l Performance Requirements

| - Sonar Technician (Submarine) (STS)
&‘J- Reports

3. Select the title of the Course to which you want to add the Module.

new 3 @O B D ®Y Sonar Technician (Submarine...
Course Title®*: Sonar Technician (Submarine) (STS)
Version: 1 Status®: New
Delivery Method:

ISD Considerations

Page 14 of 171



Content Build and Migration in Support of Sailor 2025 SOP 21 December 2016

User Tip: If you need to edit an existing Module, select the Module and then the Edit button.

Main Content ToS/Assessment Info .
new 3 O & OO ®R K Sonar Technician Submarines...
-4 Project Management Ganeral Sill Basis.
=4 Curmiculum Development :
o ’ Performance Requirements Module Title®: Sonar Technidan Submarines (STS) Class A School

Wersion: 1 Status®: New

Delivery Method: Blended

oG Tactical Computer and Network Operator

+ Il Reports ISD Considerations

= indicates a required field.

4. Select the New icon.

_1 sl oW Sonar Technician (Submarine...
#-4p Project Management ot
=4 Curriculum Development
+ B Performance Requirements Course Title*: Sonar Technician (Submarine) (STS)
S¥ii"] Sonar Technician (Submarine) (STS) Version: 1 Status®: New
=@ Reports
Delivery Method:
ISD Considerations

5. Type the title of the Module in the Module Title* field.
a. For this stage of the Content Build Process, enter the title as [CIN].

For example, A-142-0056

b. Ifthe Module titles have already been created, they may be entered at this time.
Refer to Section 1.4.2 Changing Module Titles to Family Groups for style guide

instructions on entering Module Titles.
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Ww W@ & L0 GR X
Fedlr Mot Monagerwed
—-i Curiodhum Developrert

= § Pertormance Reguremonts

=l Senar Techwician [Submaning) (ST5)

-G Sonir Technkkn Scbmarines (5T5) Class A School
+ % Tactical Computer and Retwork Openor

B i o]

4+l Reports

New Module

[ Sl aan

Module Title®s [ b

Wersbon: 1

Delivery Method: || Select Detvery) £

® indiestes 8 tequired lield

Canced

Statis®: New

CPM.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into

6. From the Delivery Method drop-down menu, select the appropriate delivery method.

a. Choose
i.
ii.

one of the following:

IMI if the Module contains only Lessons/Sections taught by IMI, ICW, or CBT
Instructor-Led if the Module contains only Lessons/Sections taught by an

Instructor

1. Any Course taught by an LP, CAIl, and/or PowerPoint
Blended if there are both Instructor-Led and IMI Lessons/Sections within

the Module

Version: 1

(Select Delivery)
IMI

Delivery Method: | [ F T
Blended
EPSS

7. Select the Save button.
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New Module

General | Skill Basis |

Module Title *: | 1jg., todul|

Version: 1

* indicates a required field.

Status*; | Incomplets v

Delivery Method: | (Select Delivery) v

1.2.8
1. Access the Project.

Adding a Lesson to a Module

2. From the Project screen, select the + icon to expand the Course title.
3. Select the title of the Module to which you want to add the Lesson.

Nw 3B @B 00O % X
#-4p Project Management

=4 Curriculum Development

® ' Performance Requirements

=) Sonar Technician (Submarine) (STS)

1
- lScnar Technician Submarines (STS) Class A Schwll

[;:-Q Tactical Computer and Network Operator
# @ Reports

Sonar Technician Submarines...

| General

Skl Basis

Module Title®*: Sonar Technician Submarines (STS) Class A School
Version: 1 Status®: New
Delivery Method: Blended

ISD Considerations

New 3 @ & LD O W X
#-4» Project Management
=4 Curriculum Development
| @@ Performance Requirements
= Sonar Technician (Submarine) (STS)
B+ Sonar Technician Submarines (STS) Class A School
| .'-_.Q
I - TMA Fundamentals and Application
| @ Dynamic Team Training
| @@ Deyto Day Operations
& © Tactical Computer and Network Operator
-8 Reports

User Tip: If you need to edit an existing Lesson, select the Lesson then the Edit button.

In-Rate Principles

-Cw:nlﬂi

Skl Bass

Lesson Title®: In-Rate Principles
Version: 1 Status®: New
Delivery Method: Blended

ive; (None)
(Incomplete)

* indicates a required field.

4. Select the New icon.
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J’B@H‘J‘.‘J’ﬂ\hx

-4 Project Management
=4} Curriculum Development
| B rerformance Requirements
=-ffl) Sonar Technician (Submarine) (STS)
| &e
#-@ In-Rate Principles
| @@ TMA Fundamentals and Application
- @ Dynamic Team Training
| @ Dayto Day Operations
[+ Tactical Computer and Network Operator
+- @ Reports

5. Type the title of the Lesson in the Lesson Title* field.

v GO G ODOGY R
5 Propt Managemment
p Curmcukam Development
4 [ Performance Requirements.
=il Senar Techracian (Submarne] (5T5)
= G Sonar Technacian SUbmannes (ST5) Cas A Schonl
F- brfale Pincpes
S THA Pundementals and Appication
k- Dyrasic Toam Traming
3-8 Dy to Day Operatons
L}
-G Tactical Computer and hetwork Operater
= [l Repors

a. Extract the title from Column D of the Rating CCTD.

Style Guide:

New Lesson

Cararal el B

(LR L CY T —

Dralivary Method: || Select Dellvery | W

et [Hoea)
| Eecomplete)

e |

= inchcutes & Pequired fiskd

SER I fhre

Enter the Lesson title in title case without a verb. For example, “Perform diesel engine
maintenance” would become “Diesel Engine Maintenance.” If no verb is included, use the

entered Lesson title in title case.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into

CPM.

6. From the Delivery Method drop-down menu, select the appropriate delivery method.
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New Lesson

General | Skill Basis

Lesson Title*: | o | asson

Version:

(Select Delivery)
IMI

Delivery Method:

Blended
Objective: |EPSS

(Incomplete)

a. Choose one of the following:
i. IMI if the Lesson contains only Sections taught by IMI, ICW, or CBT
ii. Instructor-Led if the Lesson contains only Sections taught by an Instructor
1. Any Course taught by an LP, CAl, and/or PowerPoint
iii. Blended if there are both Instructor-Led and IMI Sections within the Lesson

7. Select the Save button.

new 3 YO GO0 O R X New Lesson
#- 4 Project Managemént -] Sl Bans.
=4 Qumiculum Development .
+ B Perfemance Requrements Lesson Tithe*: [y Lesson

=@l Sonar Technician (Submarine) (STS)
= Sonar Technician Submarines (STS) Class A School

Version: 1 Status®: Hew

+-@ In-Rate Principhes

+- @ TMA Fundamentals and Applcation Delivery Method: | (Select Delivery) v

+-@ Dynamic Team Training i
Objective: (Hone)

- Day to Day Operations. ummhtm 0)

w
- @ Tactical Computer and Network Operator
=l Reports

= indicates a required fleld

1.2.9 Adding a Section to a Lesson
1. Access the Project.
2. From the Project screen, Select the + icon to expand the appropriate Course and Module.
3. Select the Lesson title to which you want to add the Section.

New 3 B B & 0D MY X Day to Day Operations
£ Project Management General Siill Basis
=4 Curriculum Development e =
« ’ Performance Requirements Lesson Title®: Day to Day Operations
= Sonar Technician (Submarine) (STS) Version: 1 Status®: New

.;3 & Sonar Technician Submarines (STS) Class A School
+-@ In-Rate Principles

| F ive: (None)

| 2@ ™A i and Appl (Incomplete)

+- @ Dynamic Team Training
| nsideration:
B | Day to Day Operations|
#- Tactical Computer and Network Operator

-0 Reports

Delivery Method: Blended
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User Tip: If you need to edit an existing Section, select the Section title then the Edit button.

®a 0w x CPR
54 Projct Mansgement " Geeerm | Suapass
S Cummculum Development .
- Performence Requinements. Section Title*: CPR
= Sonar Technician (Submarine) (STS) Version: 1 Status®: New
= Sonar Techniclan Subrmarines (ST5) Class A School Content Type*1 Procedure Cognitive Level*1 Apply
“ @ InRate Principkes
= @ THA Fundamentals and Applcation ~ Time (in minutes): -
£ @ Oynomic Team Training D Moo S “‘h‘::
=@ Doy to Doy Operations Tastinge &
=0
- 58 Electrostatic Discharge
|25 Electrical and Blectronic Sfety m‘m’
-E5 Submarine Tagout Procedures
|8 Aftoot Safety IS0 Considerptions
22 Hazardous Materisis
|22 Honors and Ceremonies.
B Sound Slencing T r—
4 Q@ Tactical Computer and Network Operator E
4. Select the New icon.
vew ] @ & 0D G W X
-4 Project Management
=-< Curriculum Development
~- ' Performance Requirements
=-f Sonar Technician (Submarine) (STS)
H
=& Sonar Technician Submarines (STS) Class A School
| B-@ In-Rate Principles
i [#-@ TMA Fundamentals and Application
i E @ Dynamic Team Training
R Y Day to Day Operations
[+-& Tactical Computer and Network Operator
+-H Reports
5. Enter the title of the Section in the Section Title* field.
Vome Duta _occstos oA LTSS Nep Support  Logeut
Main Content ToS/Assessment Info
® & oe % New Section
-4 Project Management oo | Skl Bass
SR om—mm - — -
B Performance Requirements Section Titbe®: (jew Section
=l Sonar Technician (Submarine) (STS) ‘ |
4% Sonar Technician Submarines (STS) Class A School 7 T
@ In-Rate Principles
@ THA Fundamentals snd Applcation Content Type: | (Seect Content) vie Cognitive Level:  (Select Cognitive Level) &
=@ Dynamic Team Training
S DoytoDay "“lllﬂﬂ.l!lnﬁllﬂﬂ]r
= or Delivery Method: | (Select Defivery) v| ﬁ:
£ Electrostate Decharge Testing: 0

£ Eectrical and Blectronic Safety
= Submarine Tagout Procedures
-5 Afoat Safety
= Hazardous Materials
= Honors and Geremonies
-5 Sound Sencing
= [

% Tactical Computer and Network Operator
+ @ Reports

Objective: (Hone)
(Ineomplete)

Lom |

= indicates a required field.

a. Extract the title from Column E of the Rating CCTD.
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Style Guide:

Enter the Section title in title case without a verb. For example, “Locate diesel engine
components” would become “Diesel Engine Components.” If no verb is included, use the
entered Section title in title case.

6. From the Content Type* drop-down menu, select the appropriate content type.

(Select Content)

) Concept
Version:|rFact

Principle
Content Type*: |= o=l
Process

a. Match the drop-down selection to Column M of JDTA to_LO_Crosswalk-BlockLearn tab
in the Rating’s RATS.

User Tip: If there is more than one Content Type listed for the Section, use the highest level
(Procedure or Principle).

7. From the Cognitive Level* drop-down menu, select Apply.

Status*: New
(Select Cognitive Level)
Cognitive Level*: | .|
Remember

8. From the Delivery Method drop-down menu, select the appropriate delivery method.
a. Choose one of the following:
i. IMI if the Section is taught by IMI
ii. Instructor-Led if the Section is taught by an Instructor
1. Any Course taught by an LP, CAl, and/or PowerPoint

(Select Delivery)
IMI
Delivery Method: | (/- e tos
Blended
EPSS

9. Select the Save button.
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Nome —Dataocestos 07A TR heports  Resowces  Admin |t Support togow
Main Content ToS/Assessment Info
e a owx New Section
%4 Project Management r—— Sl Bases
=4 Curriculum Development
[ Performance Requirements Section Tithe®: [ Section

=@l Sonar Technician (Submanine) (STS)
5@ Sonar Technician Submannes (STS) Class A School

- @ In-Rate Principles i} o & )
@ TMA Fundamentals and Application Content Type®: | (Select Content) Vo ‘Cognitive Level*: | (Select Cogritive Level) Vi

Version: 1 Status®: Hew

=@ Dynamic Team Training

=@ Day to Day Operabions Time (in minutes):

- r x Class: 0
Eor Delivery Method: | (Select Deffvery) | ab: 0
£ Blectrostatic Discharge Testing: 0

£ Electrical and Electronic Safety
2= submarine Tagout Procedures.

£ Afloat Safety ufmﬂ o
£ vaznrdous Materials
£ Honors and Ceremonies
£ Sound Slencing
el Mew Section] E cancel |
@@ Tactical Computer and Network Operator = Indicates a required fleld
+ [l Reports

1.3 Export Course to Enterprise Data Environment (EDE) and Import into

Standalone LO Module
Once the Course structure is entered into CPM and the Lead Instructional Designer (ID) verifies all data is
correctly entered, the Course is exported to the EDE and imported into the standalone LO Module
instance. Once this is complete, the Course content can be entered into LO Module and additional data
can be added to the Course in CPM.

1.3.1 Exporting Courses to EDE
1. Insertyour CAC into your CAC reader.
2. Loginto AIM CPM.
3. Select the Projects tab in the top menu bar.

{2 https//cpm.prod.aim.netcnavy.mil/cpm2025/Home/HomeDisplay.aspx L - 80| E cmcon

file Edit View Favorites Tools Help

CPM 2025!

E1E] OCCSTDs JDTA Projects Reports Resources Admi

Main Events Messages Assignments My Profile

4. Select the Project Title to export.
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Projects All VI view 3 nNew b % 9% N
Project Title Version
Apprentice Technical Training (ATT) 1

Aviation Electrician's Mate (AE) 1
Cryptologic Technician (Maintenance) (CTM) 1

Logistics Specialist (LS) 1
Quartermaster (QM) 1

Sonar Technician (Submarine) (STS) 1

5. Select the Exporticon.

Home Data OCCSTDs JDTA Projects Reports Reso

Main Content

Projects [My Projects V| view & New 13 %l |3

Note: It may take a few minutes to export the project. You can do other work in CPM at this time, if
needed.

6. When finished, select the OK button on the pop-up.

Message from webpage u

A
4 !!\ (107) Export has been completed successfully! (107)

ok |

Once the export is complete, the Course is now in the EDE and ready to be imported into LO Module.

1.3.2 Importing AIM CPM Data into AIM LO Module
1. Insert your CAC into your CAC reader.
2. Loginto AIMIIL
3. Once the AIM Il screen appears, select the Learning Object Module icon on the tool bar to
access AIM LO Module.
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ZAIL =] &)

2] =

4. Select File = Import from EDE.

[ File| Options Resources Contents Edit B

Import Learning Object

Import from EDE

Update from EDE

CBT
Generate Output Package
Export RRL to EDE

Preview 4
i Generate Test Questions Package »
: Update to 12 Point Font

When the Confirm Certificate pop-up appears, confirm the information is correct, and then

select the OK button.
In the Windows Security pop-up, enter your CAC PIN.

In the Import from EDE pop-up, select the project, and then select Options = Import.

B ImportfromEDE o = o -

Optionsl Exit Help -

e |, e

e | Updated Da -

View TPP School 271972016

View COI 5t "A" School 1171772015

) 37572015

MEmicE 3LIC WORKS OFFICER 771572016
PUBLIC WORKS OFFICER BASIC COURSE 7711472016
PUBLIC WORKS OFFICER INTERMEDIATE COURSE 771572016
Quartermaster April 2016 57572016
Quartermaster Journeyman Course 571472016
Radar Module December 2013 67472015

Readiness Kill Chain
Religious Program (RP) "A" Course (2015)

3/3/2015
472872016

Resource Testing 1271042015
Robison Sandbox 571972015
RSC_Maintenance_Analysis 471572015
Sailor 2025 Training Program 973072015
Shin's Serviceman "A" Schanl RIRI201A
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Note: It may take several minutes to hours for the project to complete the import. You cannot do
anything else in LO Module at this time. The program will continue to spin while it is importing.
Occasionally it may say “Not Responding”. Typically it will catch up and correct itself. It can help to try to
complete imports in the evenings and on weekends when no one else is in the system.

Once the import is complete, the project data auto-populates.

5 Courses
File Options Resources Contents Edit Exit Help

1% i) 2] ) talef] B[] 1] 1] 250-] ] 0[5 Bl X] 1P| (-] O e et | |

Title Version | Status | Date Modified | Course | Objectives | Sheets | Resouices | Metadata |
[ER=1] AIM LOM Employee Sandbox 1 04/17/2014..

=} Modules

u Tille
< 3 1. CSCS ETIFCAScho..

1 [ 2. CSCS IC A School Sa.
¢ (1 3. CSCS/SWOS/ETCC... 0411772014

[}
1 I 04/17/2014
1 I
£ 1 1
[+ [0 4. CSSPSASchool Sa. 1 1 0411772014
1 1
1 I
1 I
1 1

0411772014 [AIM LOM Employee Sandbox

[ AN/SPS-T1 RADAR Training Set 04/16/2014... Vesion [1 Status | Incomplete -l

=} Modules
[+ 0 1. AN/SPS-T1RADART 04/16/2014....
[+}- Lessons
[+ LA Interior Communications (IC)AS...

1 [21 Radar and UHF Communications. ..

03/06/2014..
02/17/2014...

Bold items are mandatory NSCORM 2004 4th ed

User Tip: If you ever need to update a Course that has already been imported. You will
follow the same steps, except you will first select the Course in LO Module. Then select File
- Update from EDE. It will ask if you are sure, select Yes.

1.4 Add Additional Data to the Course in CPM

While content is being entered into LO Module for the Course, the Senior Team ISDs will develop and
enter the Learning Objectives for all Lessons and Sections and the Family Groups for the new Module
titles. When the content is entered and all of the Objectives and Module titles have been added, LO
Module will be updated with this information from CPM to be reflected in the LP and TG exports to the
Learning Center.

1.4.1 Adding Objectives to Lessons and Sections

Objective sentences are built by piecing together various data items to create a complete Objective. The
following steps outline the data necessary to build a Learning Objective. If the data is not listed or if an
alternative is needed, contact the CPM Management Team.

Note: When writing a Learning Objective, the ISD Considerations on the JDTA_to_LO_Crosswalk-
BlockLearn tab of the RATS should provide guidance for any “rounding-the-edges” of Objectives.

1. Select the Lesson or Section container in which the Objective will be added.
2. Select the Objective link.
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Miniature Electronics Repair

General | Skl Bass |

Lesson Title*: Miniature Electronics Repair

Version: 1 Status®: New
Delivery Method: Blended
N h

ISD Considerations

_ e |

* indicates a required field.

3. Select the Edit button.

Miniature Electronics Repair
~
v
General | Sill Basis | Assessment |
Type*: Terminal
Status®: Incomplete Explanation: 2::‘“ Verb.’é::mrd. Condition,
e 1 _cose_|

4. From the (Select Type) drop-down menu, select Condition*.
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Miniature Electronics Repair

General =1 Skil Basis | Assessment |

Type*: Terminal

e . Needs Verb, Standard, Condition,
Status™: Incomplete Explanation: Equipment/Non-Equipment
* indicates a required field.

** indicates one of these fields is required.

Search Objectives Reseguence Items

Use the drop downs on the bottom part of the screen to create the Objective text

pe Vl Delete I

Verb*
Verb-Cognitive
Verb-Psychomotor
Verb-Affective
Platform**
System™=
Subsystem**
Component**
Non-Equipment**
Environment
Tool
| _|Resource
Standard*
Free Text

Save Cancel

5. From the Condition* (Select Item) side menu, select the appropriate condition.

Miniature Electronics Repair

General Skill Basis |_ Assessment |

Type*: Terminal

5 Needs Verb, Standard, Condition,
. . " r 1
Status*: Incomplete Explanation: Equipment/Non-Equipment
* indicates a required field.
** indicates one of these fields is required.

Search Objectives Reseguence Items

Use the drop downs on the bottom part of the screen to create the Objective text

Condition* v Delete

(Show All)

VEN D VES,
USING APPLICABLE DOCUMENTS AND DIRECTIVES,

Save | Cancel I
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Note: Never reference a specific equipment or reference in the condition. Conditions should remain

general in nature.

6. From the (Select Type) drop-down menu, select Verb*.

Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION,

General | Skill Basis

| Assessment |

Type*: Terminal

Equipment

* indicates a required field.
** indicates one of these fields is required.

Status*: Incomplete Explanation: Needs Verb, Standard, Equipment/Non-

Search Objectives Reseguence Items
Use the drop downs on the bottom part of the screen to create the Objective text
| condition* | GIVEN APPLICABLE DOCUMENTATION, V| Delete |
/o V| Delete |
Verb*

oA
Verb-Cognitive
Verb-Psychomotor
Verb-Affective
Platform**
System™*
Subsystem™*
Component*=
Non-Equipment®*
Environment
—{Tool

Resource
Standard*

Free Text

Save Cancel |

From the Verb* (Select Item) side menu, select the appropriate verb. See Appendix
A for a list of Verbs in CPM.
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Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION,

General Skill Basis Assessment

Type*: Terminal

Needs Verb, Standard, Equipment/Non-

£ 1 .
Status*: Incomplete Explanation: Equipment

* indicates a required field.
** indicates one of these fields is required.

Search Objectives Resequence Items
Use the drop downs on the bottom part of the screen to create the Objective text

Condition* | GIVEN APPLICABLE DOCUMENTATION, V| Delete
Verb* v Delete

(Show All)
COORDINATE
DIRECT
MAINTAIN
MANAGE

[PerForM ]

Save Cancel

Note: If there is an action verb that is not in the list of verbs to use that would be better suited for the
Objective; submit it to the NETC CPM Management team for approval.

User Tip: Speed up finding the correct verb by typing the first letter of the verb. This will
bring the list to the first verb starting with that letter. Then, scroll to and select the
appropriate verb.

b. Found in Columns J (Lessons) or K (Sections) of the JDTA_to_LO_Crosswalk-
BlockLearn tab in the Rating’s RATS. If no verb is used, choose the applicable
performance verb.

Note: Using one of the seven performance verbs is preferred but not required.

7. From the (Select Type) drop-down menu, select Free Text.
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Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM

General | Skill Basis | Assessment |

Type*: Terminal
Status*: Incomplete Explanation: Needs Standard, Equipment/Non-Equipment

* indicates a required field.
** indicates one of these fields is required.

Search Objectives Resequence Items

Use the drop downs on the bottom part of the screen to create the Objective text

Condition* V| GIVEN APPLICABLE DOCUMENTATION, M| Delete
Verb* | PERFORM V| Delete

ale - V| Delete
Condition™

Verb*
Verb-Cognitive
Verb-Psychomator
Verb-Affective
Platform**
System™*
Subsystem™**
Component**

L] Non-Equipment™*
Environment

Tool

Resource Save Cancel

Standard*® 4' —I
ree ext

a. Select the blank field to the right of Free Text, and type in the appropriate behavior text.
b. Enter the object of the behavior in free text. Found in Columns J (Lessons) or K
(Sections) of the JDTA_to_LO_Crosswalk-BlockLearn tab in the Rating’s RATS.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Note: Casing of this text does not matter. CPM will automatically make all Objective text in All Caps.

c. Select the Update button.

Page 30 of 171



Content Build and Migration in Support of Sailor 2025 SOP 21 December 2016

Miniature Electronics Repair

General

Skill Basis

* indicates a required field.
** indicates one of these fields is required.

Assessment |

Type*: Terminal

Status*: Incomplete Explanation: Needs Standard, Equipment/Non-Equipment

GIVEN APPLICABLE DOCUMENTATION, PERFORM

Search Objectives Reseguence Items
Use the drop downs on the bottom part of the screen to create the Objective text
Condition* | GIVEN APPLICABLE DOCUMENTATION, V| Delete
Verb* | PERFORM V| Delete
Free Text W |MINIATURE ELECTRONICS REPAIR I l Update Delete

Save | Cancel

Note: If you ever need to change the Free Text, you must select Update again for the text to be updated

in the Objective.

8. From the (Select Type) drop-down menu, select only one of the following:

a.

b
c.
d.
e

Platform**
System**
Subsystem**
Component**
Non-equipment**
i. For example, forms or software

The following flow chart may be used in determining what to select.
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Tasks (Columns G-H in
As-Is EOs indicate a  § JDTA_IPRD_Final tab) - S
A Platform is listed in
System, Subsystem, reference a System, : Enter the Platform
Column L of the - .
Component, or Non- Subsystem, listed.

equipment. Component, or Non- U1 (G FERE)

Select appropriate g Select appropriate
System, Subsystem, System, Subsystem Select Platform: All
Component, or Non- Component, or Non- Platforms
equipment. equipment.

Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR A
v
General Skil Basis | Assessment |
Type*: Terminal
Status*: Incomplete Explanation: Needs Standard, Equipment/Non-Equipment
* indicates a required field.
** indicates one of these fields is required.
Search Objectives Reseguence Items
Use the drop downs on the bottom part of the screen to create the Objective text
Condition* | GIVEN APPLICABLE DOCUMENTATION, V| Delete
~
Verb* ~ | PERFORM | Delete
Free Text W |MINIATURE ELECTRONICS REPAIR ] U_pdane' Delete
V| Delete
Condition*
Verb™
Verb-Cognitive
Verb-Psychomotor v
Verb-Affective
R
System™®* ] )
L_| :ugsystem“
Component**
Non-Equipment**
Environment : I
Tool Save Cancel
Resource
Standard*
Free Text

9. From the (Select Item) side menu of the selected Objective data type, select the appropriate
entry.
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Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR

General i| Skill Basis | Assessment ‘

Type*: Terminal

Status*: Incomplete Explanation: Needs Standard, Equipment/Non-Equipment
* indicates a re] FLIGHT CONTROL SYSTEM
% indicates on| FUEL OIL (FO) AND LUBE OIL (LO) SERVICE SYSTEM A

FUEL QUANTITY SYSTEM

GENERATOR CONTROL AND MONITORING SYSTEM
GENERATOR SYSTEM

Use the drop downs on {HEATING SYSTEM

HYDRAULIC SYSTEM

Condition* W | INERTIAL NAVIGATION SYSTEM (INS) Delete
JET IGNITION SYSTEM

Verb® V| LANDING GEAR SYSTEM Delete

Free Toxt v | MAGNETIC FIELDS AND COMPASS SYSTEM Seie
MAIN DRAINAGE SYSTEM

System** W | MAIN LUBE OIL (LO) SYSTEM Delete

MAIN PROPULSION SHAFTS
MECHANICAL SYSTEM

NAVAL AVIATION LOGISTICS COMMAND MANAGEMENT INFORMATION SYSTEM (NALCOMIS)
NAVIGATION SYSTEM

NOSEWHEEL STEERING SYSTEM

OIL PURIFICATION SYSTEM

OIL SERVICE SYSTEM

OIL TRANSFER SYSTEM

OILY WASTE WATER SYSTEM

PIPING SYSTEM

PITOT-STATIC SYSTEM

SEAWATER CIRCULATING SYSTEM
SECONDARY DRAINAGE SYSTEM
SOLID-STATE FIRE WARNING SYSTEM

Note: You may need to select (Show All) to display the entire list of Platforms, Systems, Subsystems,
Components, or Non-Equipment.

User Tip: Speed up finding the correct platform by typing the first letter of the platform. This
will bring the list to the first platform starting with that letter. Then, scroll to and select the
appropriate platform.

See Appendix A for a detailed list of options.

10. From the (Select Type) drop-down menu, select Standard*.
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Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR SYNCHRO INDICATING SYSTEM

General U Skill Basis I[ Assessment |

Type*: Terminal
Status®: Incomplete Explanation: Needs Standard

* indicates a required field.
** indicates one of these fields is required.

Search Objectives Resequence Items

Use the drop downs on the bottom part of the screen to create the Objective text

Condition* | GIVEN APPLICABLE DOCUMENTATION, V| Delete

Verb* V| PERFORM V| Delete

Free Text W |MINIATURE ELECTRONICS REPAIR Update Delete
W

System** SYNCHRO INDICATING SYSTEM V| Delete

& pe V| Delete
Condition*

Verb*
Verb-Cognitive
Verb-Psychomotor
Verb-Affective
Platform**

| System=*
Subsystemn™*

Component**

Non-Equipment** Save I Cancel |
Environment
Tool
Resource
Standard*
Free Text

11. From the Standard* (Select Item) side menu, select the appropriate standard.

Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR SYNCHRO INDICATING SYSTEM

General “ Skill Basis | Assessment |

Type*: Terminal
Status*: Incomplete Explanation: Needs Standard

* indicates a required field.
** indicates one of these fields is required.

Search Objectives Resequence Items
Use the drop downs on the bottom part of the screen to create the Objective text

Condition* V| GIVEN APPLICABLE DOCUMENTATION, V| Delete
Verb* | PERFORM V| Delete
Free Text /| MINIATURE ELECTRONICS REPAIR | Update | Delete
System** | SYNCHRO INDICATING SYSTEM V| Delete
Standard* ele =
(Show All)
IAW APPLICABLE DOCUMENTS AND DIRECTIVES
IAW NALCOMIS USERS GUIDE, NALCOMIS; RSUPPLY USER GUIDE, RSUPPLY HELP FILES; NAVAL AVIATION MAINTENANCE PROGRAM, CNAFINST 4790...
IAW NAVAL SUPPLY PROCEDURES MANUAL, NAVSUP P-485 AND LOGISTICS SPECIALIST SUPPLY FUNDAMENTALS, NAVEDTRA 15004
IAW NAVAL SUPPLY PROCEDURES MANUAL, NAVSUP P-485; LOGISTICS SPECIALIST SUPPLY FUNDAMENTALS, NAVEDTRA 15004; AND NAVAL AVIATIO...

IAW NAVAL SUPPLY PROCEDURES MANUAL, NAVSUP P-485; LOGISTICS SPECIALIST SUPPLY FUNDAMENTALS, NAVEDTRA 15004; MILSTRIP INSTRUCT...
TAW NAVY CUSTOMER SERVICE MANUAL, NAVEDTRA 14056
IAW NAVY CUSTOMER SERVICE MANUAL, NAVEDTRA 14056
IAW NAVY ENLISTED OCCUPATIONAL STANDARDS, NAVPERS 18068F VOL I
IN ACCORDANCE WITH SPECIFIED PROCEDURAL STEPS.
L

] WITHIN TIME CONSTRAINTS.
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Note: Never reference a specific equipment or reference in the standard. Standards should remain
general in nature.

User Tip: Speed up finding the correct standard by typing the first letter of the standard. This
will bring the list to the first standard starting with that letter. Then, scroll to and select the
appropriate standard.

12. Read the Objective to ensure it is a grammatically correct sentence.

Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR SYNCHRO INDICATING SYSTEM WITHIN TIME CONSTRAINTS.

a. Add articles, conjunctions, and prepositions using Free Text as necessary to
complete the sentence.
i. From the (Select Type) drop-down menu, select Free Text.

Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR SYNCHRO INDICATING SYSTEM WITHIN TIME CONSTRAINTS.

General | Skill Basis | Assessment |

Type*: Terminal

Status*: | Incomplete v

* indicates a required field.
** indicates one of these fields is required.

Search Objectives Reseguence Items

Use the drop downs on the bottom part of the screen to create the Objective text

Condition* V| GIVEN APPLICABLE DOCUMENTATION, V| Delete
Verb* | PERFORM V| Delete
Free Text W |MINIATURE ELECTRONICS REPAIR Update Delete
System** V| SYNCHRO INDICATING SYSTEM V| Delete
e WITHIN TIME CONSTRAINTS. V| Delete

Condition®
Verb* V| Delete
Verb-Cognitive
Verb-Psychomotor
Verb-Affective
Platform**

L] System™**
Subsystem**
Component**

Non-Equipment** Save Cancel

Environment
Tool
Resource

Ed

Free Text

ii. Select the blank field to the right of Free Text, and type in the appropriate
article, conjunction, and/or preposition.
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iii. Select the Update button.

Miniature Electronics Repair

General “ Skill Basis | Assessment |

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR SYNCHRO INDICATING SYSTEM WITHIN TIME CONSTRAINTS.

Type*: Terminal

Status™: | Incomplete ~

* indicates a required field.
** indicates one of these fields is required.

Search Objectives

Use the drop downs on the bottom part of the screen to create the Objective text

Reseguence Items

Condition* V| GIVEN APPLICABLE DOCUMENTATION, V| Delete
Verb* | PERFORM V| Delete
Free Text WV |MINIATURE ELECTRONICS REPAIR } Update Delete
System** W | SYNCHRO INDICATING SYSTEM | Delete
Standard* V| WITHIN TIME CONSTRAINTS. | Delete
Free Text W |on thel * II Update | Delete

Save Cancel |

13. Select the Resequence Items link to resequence the Objective data into a grammatically

correct sentence.
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Miniature Electronics Repair

General l Skill Basis Il Assessment ‘

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR SYNCHRO INDICATING SYSTEM WITHIN TIME CONSTRAINTS. ON THE

Type*: Terminal

Status*: i[ncomplete A\

* indicates a required field.
** indicates one of these fields is required.

Search Objectives nce Items
Use the drop downs on the bottom part of the screen to create the Objective text
Condition™® “| GIVEN APPLICABLE DOCUMENTATION, V| Delete
Verb* V| PERFORM V| Delete
Free Text W | MINIATURE ELECTRONICS REPAIR | Update Delete
System™** W | SYNCHRO INDICATING SYSTEM V| Delete
Standard*® V| WITHIN TIME CONSTRAINTS. V| Delete
Free Text W |on the | Update Delete
(Select Type) v V| Delete

Save

Cancel I

a. Select the Objective data item you would like to move, drag it to the new position,

and unselect to drop it.

Miniature Electronics Repair

Drag &amp; Drop a row to resequence the items...

Seq

Text

a v A WN

Given applicable documentation,

PERFORM

MINIATURE ELECTRONICS REPAIR

Synchro Indicating System
within time constraints.

on the

L3 6. on the
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Note: Drop to Objective data item on top of the new position. In this example, item number 6 is
dropped on top of item number 4 so that item number 6 will become the new item number 4 and item
number 4 and all subsequence items will fall below that item.

b. Select the Save button.

Miniature Electronics Repair

Drag &amp; Drop a row to resequence the items...

Seq Text

1 Given applicable documentation,

2 PERFORM

3 MINIATURE ELECTRONICS REPAIR
4 on the

5 Synchro Indicating System

6 within time constraints.

14. Select the Save button to exit the Objective edit screen.
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Miniature Electronics Repair

GIVEN APPLICABLE DOCUMENTATION, PERFORM MINIATURE ELECTRONICS REPAIR ON THE SYNCHRO INDICATING SYSTEM WITHIN TIME CONSTRAINTS.

General Skill Basis Assessment

Type*: Terminal

Status™*: |Incomplete W

* indicates a required field.
** indicates one of these fields is required.

Search Objectives Resequence Items
Use the drop downs on the bottom part of the screen to create the Objective text
Condition™ | GIVEN APPLICABLE DOCUMENTATION, | Delete
Verb* V| PERFORM V| Delete
Free Text W | MINIATURE ELECTRONICS REPAIR J Update ! Delete
Free Text W |on the ‘ Update Delete
System** V| SYNCHRO INDICATING SYSTEM V| Delete
Standard* W | WITHIN TIME CONSTRAINTS. V| Delete
(Select Type) v V| Delete
| Cancel |

1.4.2 Changing Module Titles to Family Groups

When the Modules are first entered, they are entered using the CIN for each Course within the Rating.
Before the LP and TG are exported for Learning Center review, the Module titles need to be updated to
the appropriate Family Group/JDTA Duty titles.

1. Using the Block Learning Recommendations Report, determine the Family Groups for each CIN.

2. Change the first Module title from the CIN to the first Family Group title found in the Block Learning
Recommendations Report for that CIN.

3. Add additional Modules, as needed, so that each Family Group for the first CIN has a Module.
4. Resequence the Modules so that all the newly added Family Groups are underneath the first Module.
5. Move each Lesson from the first Module into the appropriate Family Group.

6. If a Lesson is split between two Family Groups (Modules), make another Lesson (copying all of the
same information from the original Lesson) in the second Family Group. Then, move only the Sections
that belong to the second Family Group from the original Lesson to the duplicated Lesson.

1.5 Recreate As-Is Graphics
The Graphic Artist will format graphics appropriately for LO Module and will recreate any graphics that
need the quality improved.
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All TG Sheet graphics will need to be prepared to be entered into the TG Sheets. Any images in the LP
will not be used in the new LP.

TG Sheet graphics need to have the following specifications:

e  Fit within 1950x2550 pixels (that’s 300 pixels per inch) or 6.5 in. x 8.5 in.
0 This is the space available within a TG Sheet in which content can be entered.
0 This does not mean that the graphic should fill this entire space. The graphic should
remain true to its actual size within the original TG Sheet.
e Saved as a JPEG image.
e Saved at 300dpi.
e Named with the following naming convention:
0 [Rating] [ Course Title] [Lesson Title] [Sheet Type] [Sheet#] [Image#]
i. Example: LS_LSA_Matldent_IS_01-02_4
i. Ratingis entered as the acronym in all caps.

1. Inthe above example the full Rating is Logistics Specialist (LS).
iii. Course Title is entered as a shorthand or abbreviated version of the Course
title.
1. Inthe above example the full Course title is LS ‘A’ School
iv. The Lesson Title is entered as a shorthand or abbreviated version of the To-Be
Lesson Title.
1. Inthe example above the full To-Be Lesson title is Material
Identification.
v. Sheet types are entered as follows:
1. AS = Assignment Sheet
DS = Diagram Sheet
IS = Information Sheet
JS = Job Sheet
OS = Outline Sheet
6. PS=Problem Sheet
vi. Sheet# is entered as To-Be Section#-Sheet#, in which the Sheet# is the number
of the Sheet within the Section.
vii. Image# represents the number of the image within the sheet. If it’s the first (or

vk W

only) image on the sheet, the image number is 1. If it’s the second image on the
sheet, the image number is 2.

1.6 Migrate Content into Course Structure in LO Module

1.6.1 Preparing Content Materials for AIM LO Module
Prior to entering content into LO Module, resources and graphics should be added into AIM for easy and
accurate entry into the LP and TG.
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1.6.1.1 Adding Items to Site Resource Requirements List (RRL)

Each Course Training Course Control Document (TCCD) contains an RRL that must be entered into the
Site RRL. The RRL for Courses developed using AIM | are found in Annex B of the TCCD, while the RRL for
Courses developed in AIM Il are found in Annex A of the TCCD.
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Example of AIM | Course TCCD (RRL in Annex B)

TRAINING COURSE CONTROL DOCUMENT
TABLE OF CONTENTS

Coptents Faze
Leterof Prommilgation
Pamnt. ... cvaiasissnss vowe mominsasisn ase

w o e

‘Outline of Instruction . . . b S A e P et 10
ANNEX A: Profile Item-to-Topic Objective Asagnment Chart

[AMRNEX B: Rezource Requirements Lizt |

ANNEX C: Course Master Schedule
ANNEX D: Fault Appheabibty List
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Example of AIM Il Course TCCD (RRL in Annex A)

Unclassified

TRAINING COURSE CONTROL DOCUMENT

TABLE OF CONTENTS

Lantani Bage
Letter of Promulgation

Table of Contents 8 i 4 e i 1
Foreword

Course Data

Tranee Data 12
Outline of [nstruction Summary 13
Curriculum Outline of Instruction i 3% S ERE AL e Ee ABcamEy 16

| ANNEX A- Resource Requirements List |

ANNEX B: Course Master Schedule

Unclassified

Note: Avoid entering the following types of information into the Site RRL:

e |nstructor/Trainee Workstations

e Lesson Plans

e Trainee Guides

e Proctor Guides

e Assessments

e Paragraph, Chapter, or any related information
e Duplicate resources

To add resources to the RRL:

1. Open the AIM Il software.
2. Under Utilities, select Site RRL.
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3.

Utilities | Window Bat  Help
Change Password
Site RRL
Graphics

Associated Curriculum Documents
Admin Utility

Reporting

RRL/Graphics Location Tool
Learning Site

Agency

Archive/Unarchive

Import/Export

User

Data Manager

In the Site Resource Requirements List pop-up menu, select the appropriate Resources folder
for the type of resource you are entering.

- Tt
[ Site Resource Requirements List = | B

Options Exit Help

D &l IR 9|9| Zl [<Enter search criteriahe _Find | Clear |

I Resources * || Document Title l Document Number l Status gl
-3 Calibration & COSAL for CVN 901 US Complete
(3 Computers @ DoD Postal Manual DoD 4525.6 (Series) Complete

[ Consumables @ Domestic Mail Manual USPS Publication Complete
(3 Equipment P FEDLOG Current Electronic Complete
(1 Equipment Refur @ Intemational Mail Manual USPS Publication Complete
3 Films A Logistics Specialist Postal Fundamentals NAVEDTRA 14317A Complete |=
{21 Hend Tools @ Logistics Specialist Supply Fundamentals, NAVEDTRA 15004 Complete
I ET™ L |[| @ MILSTRIP Instruction NAVSUPINST 4235.2 Complete
2 01 IMM & NALCOMIS Stock Summary Performance .. Complete
& Animation & Naval Aviation Maintenance Program CNAFINST 4790.2 (series) Complete
£ Audio & Naval Supply Procedures Manual NAVSUP P-485 Complete |
2 Graphi @ Nawy Customer Service Manual NAVEDTRA. 14056 Complete
Wi @ Nawv Postal Instruction OPNAVS1126 (Series) Complete_~
g S?jwerpoint Document Title:
laeo COSAL for
(2 Simulations |~
22 Maintenance Tra Document Number:
(3 Miscellaneous M CVN 901 US
(1 Ordnance
{2 Photographs Status: Complete
O Prefaulted
a
2 Slides
L Sai ™
< m | »
e ———

a. The Resources folders in the RRL are categories and sub-categories of resources. The
resources in the TCCD may not directly align with the categories and sub-categories in
the Site RRL. The information shown in the below table provides guidance as to which
category to place a resource, if the category varies from the AIM | and/or AIM Il
generated TCCD. If an item in the RRL - AIM | or RRL - AIM |l columns is blank, the
category is the same as noted in the RRL - AIM LO Module column.
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RRL - AIM LO Module RRL-AIM | RRL-AIMIII
(Annex B of TCCD) (Annex A of TCCD)

Calibration

Computers

Consumables

Equipment

Equipment Refurbished

Films

Hand Tools

[ETM

IMM (Animation, Audio, Graphic, Films/Videotapes/Videodiscs, | CBT
Internet, PowerPoint, Simulations) Graphics, CBT, PC Simulations

Maintenance Trainers

Miscellaneous Materials

Ordnance

Photographs

Prefaulted

Publications References, ALL FORMS ALL FORMS

Slides

Software

Special Tools

Support Equipment

Test EQuipment

Training Devices

Training Equipment

Training Materials Texts, Support Materials

Transparencies

VI Equipment

Videos

Wall Charts

4. Review the entries within the category folder to ensure the resource has not been added
already.

Note: Resources may have been entered slightly differently in the RRL, so check closely. Contact
CPM Management for discrepancies in resource titles.
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e
3. Site Resource Requirements List - Active ;@ X
Options Contents Exit Help

D &|[& MI&IYIQlO] ll |<Enter search criteria here> Find | Clear |

= Resaurces Document Title | Document Number [ Security ... | Status |

2 Calibration D (IETM) AN/BOQ-10 System Operations and Maintenance... Various wy Complete =
i 1 Computers & 04409010 DD (8] Complete
{1 Consumahbles @ 10014925 REVAD ()] Complete
(] Equipment @ 14 Multi-Service Tactics, Techniques, and Pracedures fo.. NTTPE-02.8 (8] Complete
{1 Equipment Refurbished | @ 3COM Switch 5500 Family Getting Started Guide 10014925 REV AD y Complete
i3 Films & 3M MANUAL OPNAY 4790.3D CH 4 )] Complete
(3 Hand Tools D 638850 SONAR SYSTEMS V 2.0 SOBT ICW DODUSNSLCSO..  (U) Complete
1 ETM D 77A123849 RevA ()} Complete
a0 IMM g??m 23849 Rev A, Configuration Item Product Function Sp.. Unit 871 [9)] Complete
. . @ 77A123851 RevC ) Complete
g mz:gfnﬂ::;fm . | @77arzase RevB () Complete
(3 Ordnance B 77A123861 Rev B pages 55 and 56 ()] Complete
& Ph " B 774125586 RevG ) Complete
olographs B A+, Network+, Security+ Exams in a Nutshell (2007) As, Network+, Security+ Exam...  (U) Complete

~Q Prefeutted D AAR2LCE-TE (1998) VNswitch 900 Series Technic.. (U} Complete ™

=T
() Slides
[ Software
\--(1 Special Tools

-1 Support Equipment Document Number:
-1 TestEquipment OPNAYINST 510019
[ Training Devices
(2 Training Equipment
+ (0 Training Materials
{1 Transparencies
(23 VI Equipment
-3 Videos
2 Wall Charts

Document Title:
Nany Occupational Safety and Health (NAVOSH) Program Manual for Forces Afloat

Security Marking:
UNCLASSIFIED

Status: Complete

5. If the resource is not present, select Options = Add Resource.

[, Site Resource/Requirsments Ci
Options | Exit Help
Add Resource I
Moedify/View Resource
Delete Resource

Grant Privileges
Replace...

Display Related Materials
Flag Related Materials

Display Unused Resources
Search Site RRL

SCORM Metadata
SCORM Package

Explain Flag

Print Preview
Print
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6. Inthe pop-up window, enter the appropriate information for the resource exactly as it appears

in the TCCD. The required fields and guidance on entering information for a resource in each

category are shown in the below table.

RRL - AIM LO Module

Required Fields

Guidance

Calibration

Nomenclature

Computers

Nomenclature

Only enter if related to the task and not an
item used by the instructor to prepare for
training.

Consumables

Nomenclature

Equipment Nomenclature
Equipment Refurbished Nomenclature
Films Designator If there is no official Designator indicated in
Title the TCCD, enter “(No Designator)” in the
Designator field.
Hand Tools Nomenclature
IETM Contact CPM Management for guidance on

entering an IETM.

IMM (Animation, Audio,
Graphic, Internet,
PowerPoint, Simulations)

Designator
Title

Enter all items under the IMM category folder
and avoid using the related sub-folders.

If there is no official Designator indicated in
the TCCD, enter “(No Designator)” in the
Designator field.

Maintenance Trainers

Nomenclature

Miscellaneous Materials

Nomenclature

Ordnance Nomenclature
Photographs Number If there is no official Number indicated in the
Title TCCD, enter “(No Number)” in the Number
field.
Prefaulted Nomenclature
Publications Title If there is no official Document Number
Doc Number indicated in the TCCD, enter “(No Doc.
Number)” in the Doc Number field.
Slides Title
Software Title

Special Tools

Nomenclature

Support Equipment

Nomenclature

Test EQuipment

Nomenclature

Training Devices

Nomenclature

Training Equipment

Nomenclature

Training Materials

Nomenclature

Avoid entering the following types of
information into the Site RRL (maybe appear
under the Texts or Support Materials
heading):
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Instructor/Trainee Workstations
Lesson Plans
Trainee Guides

e Handouts
e Proctor Guides
e Assessments
Transparencies Title
VI Equipment Nomenclature
Videos Designator If there is no official Designator indicated in
Title the TCCD, enter “(No Designator)” in the
Designator field.
Wall Charts Number If there is no official Number indicated in the
Title TCCD, enter “(No Number)” in the Number

field.

a. Publications display as: Title, Doc Number.

For example, Logistics Specialist Postal Fundamentals, NAVEDTRA 14317A would be entered as follows:

-
£ Publications - Logistics Specialist Postal Fundamentals [ESE——

Edit Exit Help

Title |l ogistics Specialist Postal Fundamentals

Doc Number [NAVEDTRA 14317A

Supplier |

| un—

Unit Ccstl

If there is no official Document Number indicated in the TCCD, enter “(No Doc. Number)” in the Doc
Number field. For example, Dutton’s Nautical Navigation (15th Edition), with no document number,

would be entered as follows:

B3 Publications

.

Edit Exit Help

| Tile [Dutton's Nautical Navigation (15th Edition) |

I Doc Number |(No Doc. Number)

Supplier |

U/l Ii

Unit Cost
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If the official Document Number indicated in the TCCD is not an actual document number, enter “(No
Doc. Number)” in the Doc Number field.

For example, below is an excerpt from a TCCD that places composers under the Number column.

5. Publications

NO. NUMBER TITLE

j 8 Mayeur 10 Duos for Two Saxophones

2. 233 10 Duos for Two Saxophones - Mayeur
3 Handel 10 Sonatas for Flute and Piano

4. Mozart 11 Mozart Duets

S Bozza 12 Etudes and Caprices for Saxophone

A solution is to enter “(No Doc. Number)” in the Doc Number field and place the composer in
parentheses after the title when entering each publication.

Title: 10 Duos for Two Saxophones (Mayeur)
Doc. Number: (No Doc. Number)

In this example, there are multiple adjustments. The first two references indicate Revisions or Changes
under the Doc. No. field in the TCCD. The last two references indicate CSOSS information under the Doc.
No. field in the TCCD.

L L
I WS SN

s N . 2N N
’ . . [ “ .
" B e o b |

A solution to the first is to remove the phrases “Rev. B” and “Chg.3,”and add “(Series)” to the end of the
Title field.

Title: Version Description Document for the Block | (Series)

Doc. Number: 04409010-VDD

Title: Upgrade to the AN/SQQ-89(V)6 Set 5 (Series)
Doc. Number: (No Doc. Number)
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A solution to the second is to enter “(No Doc. Number)” in the Doc Number fields for each instance and
move the CSOSS acronym to the end of the title.

Title: Combat System Operational Sequencing System (CSOSS) DDG 70

Doc. Number: (No Doc. Number)

Title: Combat System Operational Sequencing System (CSOSS)

Doc. Number: (No Doc. Number)

In this example, the nomenclature for a piece of equipment appears under the Doc. No. field in the
TCCD. The title is also lower case, and should always be title case.

- . -
‘—-s\-‘ - . z'
- 2%

- A e &, & 2

A solution is to enter “(No Doc. Number)” in the Doc Number field and change the title to title case.

Title: OKI-C6100 User’s Manual
Doc. Number: (No Doc. Number)
b. Computers display as: Nomenclature.

For example, Computers, OPTIPLEX 360 would be entered as follows:
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a.

3 Computers - Computers, OPTIPLEX 360

Edit Exit Help

Nomenclature [Computers. OPTIPLEX 360

No.[
AAC
[
CAGE[

Part Number |

ZOG/NIIN/SMIC |

Unit Cost [

SMaR [

'| Technical Ref. |

==

IMM displays as: Designator, Title.

For example, the CBT LS Class A - Customer Service, CSS-LSA-020 would be entered as follows:

B IMM-LSC

ass A - Customer Service

Options Edit

Exit Help

I Designator |

CSS-LSA-020

Title

LS Class A - Customer Service

Reference I

Source |

U/l Unit Cost

[ Selectafolder

File Name]

[v CopyFile To Media Directory ~ Select..

Description

-~

1.6.1.2 Adding Graphics to AIM LO Module Repository
Graphics are added to TG sheets to enhance and/or support the trainee’s learning experience. All

graphics added to TG sheets must come from the AIM LO Module repository.
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TG sheet graphics must be saved in a shared location for all individuals that will access the Course in LO
Module and/or insert graphics. The location of the graphics must be entered into the AIM.ini
configuration settings file so that they can be uploaded to the AIM LO Module repository to be inserted
appropriately into the TG Sheets.

To add graphics to the AIM LO Module repository:

1. Loginto AIM.

2. Select Utilities > Graphics.

[Utilities | Window Exit Help
Change Password

5 SiteRRL

Graphics

Associated Curriculum Decuments
Admin Utility

Reporting

RRL/Graphics Location Tool

3. Select Options 2 Add Graphic.

S

Edit Exit Help
Add Graphic
Modify Graphic
Delete Graphic 01
Replace Graphic 01

4. Navigate to the media folder your graphics are saved to.

Note: AIM will default to the folder you select here each time you log in to add graphics. Since all of the
graphics will be in the same folder, once you select the correct folder the first time, it should always
default to that folder.

. Graphics ;l - e Ed~

Name b AM 4 Date modified -
Graphics| =
YT A -L G aphlcs 11./20/2016 2:AA DA |)I
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5. Select the appropriate .jpg file = Open.

Look I . Graphics
Name -

. Source

=) 20035002
=] 20035005
=) 20035007
=] 20035008

x| - BB

Date modified -
11/29/2016 3:46 PM
7/22/2016 1:18 PM

7/20/2016 12:41 PM
7/20/2016 12:42 PM

7/20/201612:42PM  ~

< i

| »

HIENEGEREILS LSA Matident 1S_01-02_1.jpc | Open I

Filesof  |Graphic Files

j Cancel I

6. Verify the graphic that displays is the correct image.

!

Options View Exit Help

MATERIAL
I SUFPORT
DIVISIONS
|
51
l STOCK
CONTRIM

1

S6
AVIATION
STORES

7. Select Options 2 Select.

e
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[ Select Graphic

[ Options | View Exit
Open...

Select

Print...

8. Verify the graphic fits within 6.5” x 8.5”.

Note: If the graphic’s width exceeds the required parameters, AIM LO Module will not allow you to add
it to the sheet. The image must be resized by the Graphic Artist.

Options Edit Exit Help

Description Security Markir| Width Height =«

9. Using the required naming convention, type or paste the file name into the Description field.
This should exactly match the name of the file you selected. The naming convention for TG
sheet media is: [Rating]_[Course Title]_[Lesson Title]_[Sheet Type]_[Sheet#]_[Image#]

Options  Edit Exit Help

Description Security Markir| Width Height |~
LS_LSA_Matldent_IS_01-02_1 b.5(0 §

10. Select Edit = Save.

Options [Edit| Exit Help
-
Descr SaE
psa [ Cancel _
r r mernwill |

11. Select Exit.

1.6.2 Entering As-Is Content into To-Be Courses in AIM LO Module
Content will be entered as closely as it appears in the As-Is Courseware as possible.

1.6.2.1 Accessing AIM LO Module
1. Inthe AIM sign-in pop-up, sign in to AIM 1.
2. Once the AIM Il screen appears, select the Learning Object Module icon on the tool bar to
access AIM LO Module.
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=ATL I

Bl

| &1

1.6.2.2 Reviewing Lesson Structure in LO Module

Review the Lesson and Section structure prior to entering content to ensure everything was entered
correctly. If a change needs to be made, it will be made in CPM and updated in the EDE and LO Module.

User Tip: Save often and be patient when in AIM LO Module. AIM LO Module quite often
takes a few moments to update.

1. Once the Courses screen appears, access the Lesson from the Course structure.

D e eaaa—

ile Options Resources Contents Edit Exit Help

Q|| E)| B u| W] | ] Bl] S| B 0lo|0] x| sl Rl-| el

#

Version
A-233-0289 Electronic Warfare Support (ES) Fundamentals 1
AIM LOM Employee Sandbox
AN/SPS-T1 RADAR Training Set
Common Modules March 2014
Copy of Customer Senice
Copy of ETIFC
EDE back-up
ET IT Communication Systems Modules Archive August 2015
ET IT Communication Systems Modules February 2015
FC GM Weapons Systems Modules February 2015
IDIQ_2_Maintenance_Conversion_Project
Interior Communications {IC) A School March 2013

|

DaklsikEhikhEbng

onnnnnnn

Interior Communications (IC) A School Modules March 2013
1SD Tools

Logistics Specialist "A” School

Mavy Cash 2015

=
[+] &
+|

Status

Date h
03/10/2C
12117720
06/10/2(
01/1172C
05/18/2C
oi/272t
02172C
0872720
03/21/2C
01/26/2C
03/10/2C
10/0472(
10M16/2C
01/09/2C
0321/72C
02/09/2C

[E

Course | Objective|

Tille
-233-0289 Electron

2. Select the +icons as needed to expand the appropriate levels of the Courses, Modules, Lessons,

Sections, Elements, and Sub-Elements.
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] 1SD Tools 1
=& Logistics Specialist "A" School 1
[-]- Modules
[+] £ 1. Logistics Specialist Fundamentals 1
[+] C7 2. Logistician 1
[} C0 3. Postal Clerk 1
[} Lessons
[+]- 7 1. Postal Administration 1
[+] 3 2 Postal Administration Lab 1
[+}- 7 3. Postal Security 1
[} € 4. Postal Security Lab 1
[+]- (3 5. Operating the Automated Military Postal Sy. 1
[+ 6. Automated Military Postal System (AMPS) ... 1
[+] £ 7. Processing Incoming Mail 1
[+]. (3 8. Processing Incoming Mail Lab 1
[+] C1 9. Postal Directory Transactions 1
[+]- 3 10. Postal Directory Transactions Lab 1
[+]- 3 11. Processing Outgoing Mail 1
[+] 3 12. Processing Outgoing Mail Lab 1
[-}- 2 13. Postal Logistics 1
[+]. Overiew
[-] Sections
[=] £3 1. Conducting Postal Supplies and C 1
B 1. Introduction
[ 2. Safety Information
3. Security Information
[ 4 Fact
5. Process
[ 6. Section Review
[ Practice
[@ Assessment
7_Glossary
[+]. E3 2. Maintaining Individual Mail Lock Bo... 1
[+] Summary
[+]- [ 14. Postal Logistics Lab 1
[+]- 3 Navy Cash 2015 1

User Tip: See more of the titles by selecting and dragging to the right the line between Title
and Version at the top of the Course structure.

File Options Resources Contents Edit Exit Help
] 2] o] tuls) Bl vl 2] Ble] §) olols] w1x) Al Bl ol
o~
Title Urm | Status Dal & General
(-] £ A-233-0289 Electronic Warfare Support (ES) Fundamentals 1 | 03710
[<} Modules
[+} Cf 1. Electromagnetic (EM) Waveforms 1 | 03/10:
[+] (3 2. Electromagnetic (EM) Wave Propagation 1 1 03/10:
(-] (3 3. Radar 1 1 03110,
[=] Lessons
B 1 I 0310 Title
=

3. Review the structure. If any information is incorrect, modify as needed or notify the Lead.

1.6.2.3 Building an LP
Lessons in AIM LO Module are made up of the following components:

e QOverview
e Sections
e Summary
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[=}- [0 AN/SQQ-28(V) Sonar Signal Pro...
- [#}- Overview

[+}- Sections

gﬂ Summary

AIM LO Module generates default Elements for each component.
The default Overview Elements include the following:

e Introduction
e Importance
e Prerequisites

e Scenario

oM rreRr T T e rmesra

El C:I AN/SQQ-28(V) Sonar Signal Pro...
[} Overview
B Introduction
B Importance
-~ [A Prerequisites
- [@ Scenario

The default Section Elements are based on the content type selected during CPM data input. When the
CPM data is imported into AIM LO Module from the EDE, AIM LO Module generates Elements that
satisfy each Lesson content type. Required Elements appear as bold and cannot be deleted. Non-
required Elements appear as not bold and can be deleted. With a few exceptions, Elements within
Sections can be added, renamed, copied, pasted, and resequenced.

The following table shows the required Elements (in bold) for each content type.

Content Type When Used Element Type Requirement
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Content Type

Fact

Process

When Used

To teach unique, specific, one-of-a-
kind pieces of information that is
presented as:

e Statements
e Data
e Pictures of specific objects

To teach how a system works and

can be defined as:

o A flow of events that describes
how something works
e Not a task to be done by one

Element Type

Requirement

Introduction Required
Safety Information | Optional
Security Optional
Information

Interaction Optional
Fact Required
Section Review Optional
Practice Required
Assessment Required
Glossary Optional

Introduction Required

Safety Information | Optional

Security Optional
Information

Fact Optional
Interaction Optional

Process Required (Staged
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Content Type When Used Element Type Requirement
person Table, Block
e Tasks involving many persons or Diagram, or Cycle
organizations Chart)
e Mechanical, business, or Section Review Optional
scientific Practice Required
Assessment Required
Glossary Optional

Note: An additional Element type that may be used is Interaction. This can be used for any activities,
assignments, or other instances in which the trainee would be interacting and completing a task.

The default Summary Elements include the following:

e Review
e Next Step

e Resource
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[=}- [ AN/SQQ-28(V) Sonar Signal Pro...
' Overview
Sections
[=}- Summary
: Review
Next Step

: Resource

Every Element has two tabs that align with the LP: Element and RIA. The information found in the
Element tab aligns with the information found in the DP heading of the LP.

Element | RiAs(0) | Metadata |
Title: [p-b Type: [Sub-Element (Text)

| IT:m&eNewHoman LI |12 j B IIl_l_J_I i=|i=

2. Introduction to Postal Service

>

a. Introduction to Lesson
b. Objective(s)

ic. Think About It .
d. What to Expect 5

m
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UNCLASSIFIED
LESSON PLAN
SECTION: (U) New Procedure Section
DISCUSSION POINT RELATED INSTRUCTOR ACTIVITY

1. (U) Introduction
(U) [Content not available]
2. (U) Military Postal Service (MPS)

a. (U) 1. Introduction

b. (U) 2. Introduction to Postal Service

a. Introduction to Lesson
b. Objective(s)

¢. Think About It

d. What to Expect

The information found in the RIA tab aligns with the information found in the RIA heading of the LP.

Element | RiAs(3) | Metadata

Source

Type | Text I
Free Text Directtrainees to complete the End-of-Lesson Assessment.

Free Text Monitor trainee progress.

Free Text Ifthe trainee is unsuccessful after two atternpts, work directly wit...
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UNCLASSIFIED
LESSON PLAN

SECTION: (U) Network Models

DISCUSSION POINT RELATED INSTRUCTOR ACTIVITY

(U) Incorporate integrity discussions into the course by
personalization of a personal expernience. denved from Force
Operational Notes (FON), lessons leamed, rate conferences,
or other genmane source.

2. (U) OSI Reference Model

3. (U) TCPAP Stack

4. (U) OSI Versus TCP/1P

(U) End-of-Lesson Assessment 5. (U) Direct trainees to complete the End-of-Lesson

Assessment.
(U) Monitor trainee progress.

(U) If the trainee is unsuccessful after rwo attempts, work
directly with the trainee to ensure comprehension.

1.6.2.3.1 Completing the Overview and Summary Element Tabs

Since none of the As-Is Courseware has a Lesson Overview or Summary currently, one will not be
created unless the Learning Center provides the content to include.

In each Lesson Overview and Summary Element (unless otherwise directed):

e Do not change the Element title.

e Enter [Content not available] into each Element.

]:EI:I OASHEOARD' and SYSTEV ADVI | Version | Status | Date Modified ii Element I Resources (0) I Metadata l
[t} " " an 1 | 12/05/2016 1... - - :
--I:l Acoustic Sensor Workspace | 12/06/2016 0. it |Intr0duct|on Type |Intr0duc1|0n
[+}- [ Acquisition and Processing Subsyst.. 1 | 09/26/2016 1.
G- 3 nircran ManagementWorl?spacey 1 I 12/08/2016 1... | Times New Roman Sl [ - B|z|u| ==
[+}- [ Alternative Storage Solutions 1 I 09/23/2016 1
[z [0 AN/SQQ-28(V) Sonar Signal Proces.. 1 | 12/05/2016 1... [Content not available] -
: Overview B
12/05/2016 1...
Importance 12/08/2016 1....
Prerequisites 12/05/2016 1.
Scenario 12/08/2016 1.

If Lesson Overview content is not specified, all Lesson Overviews should look like this:
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LESSON: (U) AN/SQQ-28(V) Sonar Signal Processing Subsystem
OVERVIEW

(U) Introduction:
(U) [Content not available]

(U) Importance:
(U) [Content not available]

(U) Prerequisites:
(U) [Content not available]

(U) Scenario:
(U) [Content not available]

If Lesson Summary content is not specified, all Lesson Summaries should look like this:

LESSON: (U) AN/SQQ-28(V) Sonar Signal Processing Subsystem
SUMMARY

(U) Review:
(U) [Content not available]

(U) Next Step:
(U) [Content not available]

(U) Resource:
(U) [Content not available]

1.6.2.3.2 Building the Section Structure
While each Section provides default Elements, you are responsible for building the structure so the
Elements in each Section align with the As-Is content.

1.6.2.3.2.1 Determining the Structure
1. Locate the Rating CCTD.
2. Find the To-Be Sections in Column E that correspond to the Section in AIM LO Module.
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A B c D E
NOTES:

1. Lesson Topics represent the "As-Is" lessons in the current Course of Instruction (COI).

2. Initial Block dation of 0* indi 2 good idate for RRL, but due to Block Learn business rules, it remains in Block 0.

3. The following courses and CINs are included in this document starting on the line indicated:
LS "A” School (A-551-1014) 1
4. To-Be Lessons and Sections are the course structure for CPM-LOM.

Line # | Topic # |As-Is Lesson Topic To-Be Lesson Titles/Objectives  To-Be Section Titles/Objectives

(from Column J of the JDTA_to_LO- (from Column K of the JDTA_to_LO-
CrosswalkBlockLearn) CrosswalkBlockLearn)

1 LS 'A’ School (A-551-1014)

2 1.1__|Rating Introduction Material Identification Identify duties and responsibilities of the Navy

3 21 |Customer Service Material Identification Identify customer service processes

4 3.1 _|Supply Organization Material Identification Discuss the orzanization of the Navy Supply

5 4.1 |Supply Security Material Identification Describe Supply Security

[ 5.1  |Matenial Identification Maternial Identification Perform Material Identification

3. Refer to Columns B and C to determine the As-Is Topics that correspond to each To-Be Section.

A B C D E
NOTES:
1. Lesson Topics represent the "As-Is" lessons in the current Course of Instruction (COI).
2. Initial Block R dation of 0* a good for RRL, but due to Block Learn business rules, it remains in Block 0.
3. The following courses and CINs are included in this document starting on the line indicated:
LS 'A’ School (A-551-1014) 1
4. To-Be Lessons and Sections are the course structure for CPM-LOM.
Line # | Topic # |As-Is Lesson Topic To-Be Lesson Titles/Objectives | To-Be Section Titles/Objectives
(from Column J of the JDTA_to_LO- (from Column K of the JDTA _to LO-
CrosswalkBlockLearn) CrosswalkBlockLearn)
1 LS 'A’ School (A-551-1014)
2 1.1 [Rating Introduction Material Identification Identify duties and responsibilities of the Navy
3 2.1 |Customer Service Material Identification Identify customer service processes
4 3.1 |Supply Orzanization Material Identification Discuss the organization of the Navy Supply
5 4.1 |Supply Secunty Matenal Identification Describe Supply Security
[] 5.1 [Maternal Identification Matenal Identification Perform Material [dentification

4. Locate the As-Is Topics for the To-Be Section in the AIM |_AIM II_Content Mapping_BL tab of the
Rating’s RATS.
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Course of Instruction (COI)
Content Type (Elements)

LOGISTICS SPECIALIST A School

1.1 Discuss job expectations of a Navy
Logostics Specialist

1.2 Describe the format of the Logistics
Specialist A school course

2.1 |dentify effective customer service
characteristocs
2.2 |dentify effective customer skills
2,3 Describe the official telephone usage
|guidelines

2.4 |dentify proper message taking elements

5. Refer to Column L of the AIM |_AIM II_Content Mapping_BL tab to determine the Element
Type(s) associated with the Topic(s).
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J K L
Main / Supporting
Course of Instruction (COI) Content Type
Content Type (Elements) Grouping # Content Type Content Type Element
LOGISTICS SPECIALIST A School
Unit 1: Rating introduction
Lesson Topic 1.1: Rating Introduction
Supporting Merge

1.1 Discuss job expectations of a Navy
Logostics Specialist Procedure Introduction
1.2 Describe the format of the Logistics
Specialist A school course Procedure Introduction

Unit 2: Customer Service

Lesson Topic 2.1: Customer Service
Supporting Merge

2.1 Identify effective customer service
characteristocs Procedure Fact
2.2 ldentify effective customer skills Procedure Fact
2,3 Describe the official telephone usage
guidelines Procedure Procedure Table
2.4 Identify proper message taking elements Procedure Procedure Table

6. Add and Change the Titles of Elements as needed to complete the Section structure. You can

also change the Element types of any optional Elements that aren’t needed instead of adding

new Elements.

7. Delete any unused optional Elements.

8. Resequence Elements if necessary. Ensure the Section content is in the correct order in

accordance with the As-Is LP.

Note: You can also Copy and Paste Elements, although there most likely will not be a need to do so.

9. Add Sub-Elements as needed to build out the rest of the content.

Note: For this project, we will only be populating the first level of sub-Elements if the Section contains

more than one As-Is Topic that is being merged. In this case, you will add a sub-Element for each
Element or DP in the As-Is Topic LP. Additional Sub-Elements from the As-Is LP will be pasted into the

first level Sub-Element’s Element tab.

Example DP in LP:
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b

Introduction to Postal Service
a. Introduction to Lesson
b.  Objective(s)

. Think About It

d. What to Expect

Example Section structure in AIM LO Module:

(L1 New Procedure Section

. 1. Introduction

= 2. Military Postal Service (MPS)
| a. 1. Introduction

b. 2. Introduction to Postal Serv

Example Sub-Element Element Tab:

Element I Rlas (0) | Metadata |
Title: |E'b Type: [Sub-Element (Text)

| Times New Roman ~l [z ] B|z|u| =[i=]

. Introduction to Postal Service -

Introduction to Lesson
. Objective(s)
. Think About It

What to Expect

If there is only one As-Is Topic in the To-Be Section, you will not build out and Sub-Elements. All content
will go at the Element level for those Sections.
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Example Structure for To-Be Section with Multiple As-Is Topics

In the following example, there are three Lesson Topics that are assigned to the same To-Be Section.

Topic # |As-Is Lesson Topic To-Be Lesson Titles/Objectives To-Be Section Titles/Objectives
(from Column J of the JDTA_to_LO- (from Column K of the JDTA_to_LO-
CrosswalkBlockLearn) CrosswalkBlockLearn)
LS 'A" School (A-551-1014)
13.1 [Military Postal Service (MPS) Various classes of mail and how to compute fees | Descnbe the Military Postal Service (MPS)
14.1 |Domestic Mail Various classes of mail and how to compute fees | Describe the Military Postal Service (MPS)
15.1 [Domestic Mail Requinng Special Services Various classes of mail and how to compute fees | Descnibe the Military Postal Service (MPS)

Therefore, there should be three Elements listed within this Section in AIM LO Module.

1. Military Postal Service (MPS)
2. Domestic Mail
3. Domestic Mail Requiring Special Services

El [:l New Procedure Section

[ 1. Introduction
2. Military Postal Service (MPS)
3. Domestic Mail
Practice
Assessment

FPEEEREE

The Element Types listed for each Topic should cover the required Elements for the Section structure.
Therefore, you may not have a need to add addition Elements to accommodate the content for the

Section. If there are any required Elements that are not used, they will be extra Elements listed in the
Section with [Content not available] entered.

Flle Options Resources Contents Edit Exit Help

ol fE @ W ale| W[ ] B S| ©) @l@(R] )] el Q-] 8l
Title 4 Element | RiAs(0) | Metadata |
E] CJ New Procedure Sectlon Tite: [rvoduch
| He: Jintroduction
2. Military Postal Service (MPS) -
1 3. Domestic Mail [ Times New Roman =2
4. Domestic Mail Requiring Special Senvices
Practice [ Content not available]
Assessment

Refer to the AIM |_AIM II_Content Mapping_BL tab to determine which Element type the Lesson Topic
should be entered as for each Element in the structure.
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Course of Instruction (COI)

Main / Supporting

)

Content Type
Groupin 0 #

Supporting

13.1 Discuss the mission and functions of the
Military Postal Services, the USPS/DoD postal
agreement, and the types of mail and services

13.2 Describe the service commitments of the
Military Postal Service (MPS) regarding
customer service and customer information

13.3 Describe postal facilities and the services
they provide

13.4 Describe general responsiblities and titles
of Logistics Specialists performing postal duties

13.5 Identify publications and manuals used in
performing dutues

13.6 Understand who can use U,S, Postal
Facilities

Supporting

14.1 Discuss the contents of the Domestic Mail
Manual

14.2 Explain the procedure to determine the size
of articles

Each DP for the Lesson Topic will be entered as a separate Sub-Element underneath the Lesson Topic

Title at the Element Level.

Topic 13.1 Military Postal Service (MPS)

DISCUSSION POINT
1. Introduction
2. Introduction to Postal Service

a. Introduction to Lesson

b. Objective(s)

c. Think About It

d. What to Expect

Mission and Functions of Military Postal Se

E} I:I Mew Procedure Section
; 1 1. Introduction

El Bl 2. Military Postal Service (MPS

1 a. 1. Introduction

] b. 2. Introduction to Postal Serv

c. 3. Mission and Functions of Mi
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No further Sub-Elements will be created. If the As-Is LP contains further sub-Element levels, all of the
content from those will be pasted into the Sub-Element textbox for the DP.

DISCUSSION POINT

3.

Mission and Functions of Military Postal Service (MPS)

Introduction
MPS Mission
MPS Function

Navy Administrative Chain-of-Command and MPS
Operational Chain-of-Command

Mission and Functions of Military Postal Service
(MPS) Knowledge Check 1

United States Postal Service (USPS) and DoD
Agreement

Element | RlAs(0) | Metadata |
Title: |p-c Type: [Sub-Element (Tex)

ITmesNewRuman E| |12 Zl B|Z|U| =|i=

3. Mission and Functions of Military Postal Service (MPS)

la. Introduction

lb. MPS Mission

lc. MPS Function

ld. Navy Administrative Chain-of-Command and MPS Operational
|Chain-of-Command

le. Mission and Functions of Military Postal Service (MPS) Knowledge
ICheck 1

. United States Postal Service (USPS) and DoD Agreement

Example Structure for To-Be Section with One As-Is Topic

In the following example, there is one Lesson Topic that is assigned to the To-Be Section.

Line # |Topic # |As-Is Lesson Topic To-Be Lesson Titles/Objectives To-Be Section Titles/Objectives
(from Column J of the JDTA_to_LO- (from Column K of the JDTA_to_LO-
CrosswalkBlockLearn) CrosswalkBlockLearn)
5 4.1  |Supply Security Material Identification Describe Supply Security

Since there is no merging of Topics for this Section, we do not need to drop the DPs down a level. There
will be one Element created for each DP in the As-Is LP for the Topic.

Introduction

No v ks wNR

Assignment

Introduction to Supply Security

Supply Security Administration
Safeguarding Supply Department Spaces
Review for Supply Security

Summary and Review
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=M= Supply Securi

Sa
1. Introduction
2. Introduction to Supply Se...
3. Supply Security Administr...
4. Safeguarding Supply D...
5. Review for Supply Security
6. Summary and Review
Practice

7. Assignment

Assessment

Die

The AIM |_AIM II_Content Mapping_BL tab may be used to determine which Element type the DPs

should be entered as for each Element in the structure. However, you may find that it does not fully

relate to the actual DPs in the As-Is LP.

| i J K L
Main / Supporting
Course of Instruction (COI) Content Type
Content Type (Elements) Grouping # Content Type Content Type Element
Unit 4: Supply security -
Lesson Topic 4.1: Supply Security
Supporting Merge

4 1 Discuss Supply Security Administration Procedure Fact

4 2 Identify requirements for Safeguarding

Supply Department Spaces Procedure Procedure Table

In this case, you should refer to the table of Content Types and Element Types in Section 1.6.2.3.2

Building the Section Structure. Use the table to choose the correct Element types for each DP in the As-

Is LP. The DPs listed for each Topic should cover the required Elements for the Section structure. If there

are any required Elements that are not used, they will be extra Elements listed in the Section with

[Content not available] entered.

For this example, the following Element Types were used:

DP

Element Type

Introduction

Introduction

Introduction to Supply Security

Security Information (Fact-List would also be fine)

Supply Security Administration Fact-List
Safeguarding Supply Department Spaces Combined Table
Review for Supply Security Fact-List
Summary and Review Section Review
Assignment Interaction
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For Sections with only one Lesson Topic, no Sub-Elements will be used. Any Sub-Element text from the
As-Is LP will be pasted into the Element Tab text box at the Element level.

2 Introduction to Supply Securnty

8 Introduction to Lesson
b. Objective(s)
c. Think About It

d. What to Expect

Title ) ) - | Version | Status; Date Modified »

[=}- 3 Supply Security (Sample) 1 I 12/08/2016...
1. Introduction 12/08/2016...
2. Introduction to Supply Se... 12/08/2016...
3. Supply Security Administr... 12/08/2016...
4. Safeguarding Supply D... 12/08/2016...
5. Review for Supply Security 12/08/2016...
6. Summary and Review 12/08/2016...
Practice 12/08/2016...
7. Assignment 12/08/2016...
Assessment 12/08/2016...

Element | RIAs(0) | Metadata |

Title: |Introduction to Supply Security

I'ﬁmes New Roman _:l I12 Ll
Introduction to Lesson

. Objective(s)

. Think About It
What to Expect]

1.6.2.3.2.2 Adding a New Element

User Tip: Save often and be patient when in AIM LO MODULE. AIM LO MODULE quite often

takes a few moments to update.

1. Select the Element prior to where the new Element should be added.
2. Select Options = Add Element = [type of Element].
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File [Options | Resources Contents Edit Exit Help
Y Create Course 8~ & olaz| 5| x| &l &«
Add Module to Course
Tail Create Element List from AIM Data | Version | Status | Date Modified
[+] Search AIM Data 1 I 05/04/2016 10:3
B . I 05/04/2016 11:1
- Add Element * I Definition | 05/04/2016 11-1
Add Sub-Element » Example
Add Note/Caution/Waming Element  *|  Non-Example I 05042016 11
Change Element Type ¢ Analogy I 05/04/2016 11:1
Rename Element Section Review
Copy Element Fact-Image I 05/04/2016 11:1
. ] 05/04/2016 11:1
Paste Element Fact-List 05/04/2016 11-1
Resequence Elements Fact-Table 05/04/2016 11:1
Storyboard Practice gmg}g H:
C Interaction 05/04/2016 11:1
opy . 05/04/2016 11:1
05/04/2016 11:1
Delete 05/04/2016 111
1
Add Test Item . gsammgjlg 11:
Modify/View Test Item 05/04/2016 11:1
05/04/2016 11:1
Delete Test Item nd the Religious Mini.. 1 I 05/04/2016 11-1
ISD Considerations ! b 016 11
[+ : 1 I 05/04/2016 11:1
= Find Course 1 | 05/04/2016 11:1
] Check Spelling 1 I 05/04/2016 11:1
Show In Use Information
1 | 05/04/2016 11:1
Reset In-Use
Explain Flag
Remove Flag 1 I 05/04/2016 11:1

User Tip: When in doubt as to which Element to add, use Fact-List.

3. Change the new Element title or text as needed by clicking in the Title or text field and typing as
needed.
4. Select the Save icon.

lesources

/@ o

User Tip: AIM LO Module automatically sequences the new Element based on the type of
Element added. If the Element is in the wrong order, resequence the Element.
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1.6.2.3.2.3 Changing the Element Title

1. Select the Element from the correct Section in the Course structure in AIM LO Module.

[-}- Lessons
= E3 1. Travel
[+}- Overview
[=}- Sections
(3 1. Request and Au...
(21 2. Defense Travel ...
G- B3

w N

. Verification of P....

2. Safety Infor...
3. Security Inf .
4. Fact
5. Process
6. Section Rev...
Practice
Assessment
i 7. Glossary

(1 4. Process Perma...
[+}. Summary

FPERRPERPRPEPEE

2. Select the Element tab and change the text in the Title field.

Type: |Inle(act\on

= Blr|y]| ==

Titie Version | Status | Date «|  Element | Rlas() | Metadata |
[ Mew Object 1 | 0202 Tile: ,E..m
[+ £ Personnel Specialist "A" School 1 | 04/2C
3 Personnel Specialist Job Sheets 1 | 04/08 —
[#}- (" Radar Module December 2013 1 | 03/0¢ |Trnu New Roman j |11
[#]- (&3 Religious Program (RP) "A" Course (2015) 1 | 05/04
[+ Cf Ship's Seniceman "A” School 1 I 031€
[ Yeoman A" School 1 | 04428
=} Modules
[# " 1. Yeoman Fundamentals 1 | 04/2¢
[ 3 2. Comespondence 1 | 04/2¢
[+ 3 3. Legal Administration 1 | 04/2¢
- [0 4. Security Administration 1 | 04/2¢
[# [N 5. Technical Administration 1 | 04/2¢
= 3 6. Travel Administration 1 | 04/2¢
[z} Lessons
= 1. Travel 1 | 0428
[+}. Overview
=} Sections
[+ (1 1. Request and 1 I 04/2¢
[ [ 2. Defense Trav.. 1 | 04/2¢
[ 1 3. Venfication o. 1 1042
E- 3 4. Process Per... 1 | 04/2¢
B 1. Process... 04/2€
2. Process.. 04/2€
B 3 Process. 05/04
4. Process... 04/2€
[B 5 Process. MIQE_I
[ 6. Process.. 04/2€
B 04/2¢
[ Practice 04/2€
[ Assessment UJ-J’ZE_'_J

Bold items are mandatory

NSCORM 2004 4th ed

3. Select Edit = Save OR select the Save icon.
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1.6.2.3.2.4 Changing the Element Type
If the predetermined Elements are not the correct Element type, or an Element with the wrong type is
added, the Element type can be changed in AIM.

Element | RlAs(4) | Metadata |

Progress Check Interaction
: Type:

Title

| | s PO G =

To change the Element type:

1. Select the Element.

0|
0-P
Q
o
= |
w

HEEEEERS
BEEB

1. Special Duty Screenings

1. Special Duty Screenings In
2. Submission of Requests for S
3. Special Programs

4. Assignment of Enlisted Perso
5. Progress Check

6 Special Duty Screening Pr.

2. Select Options = Change Element Type.

Note: The bolded, required Elements cannot be changed.
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5 Courses E |

File [ Options | Resources Contents Edit Exit Help
Ty Create Course :’J ] j E:j __gg] |‘]E| i
= 1 Add Module to Course - S
[Tl Create Element List from AIM Data Bl e Date M
[#] Create Student Sheet From AIM Data 3) ... 1 | 04/07/20
[ 1 | 03/19/20
; Search AIM Dat
E == 1 I 061020
Bl |AddBlement k 1 [ 04/20/20
1 Add Sub-Element ’ 1 | 01/12/20
E Add Mote/Caution/Waming Element » 1 ! 21‘23‘23
[+ Change Elernent Type » Section Review
E Rename Element Fact-Image
H
B Copy Element Fact-List
[+ Paste Element Fact-Table
E RELEquen{c Elements Staged Table
[# Storyboard Block Diagrams
[+ Cycle Charts
T Copy Cycle Chart:
Create New Version SR
Glossary
Delete Safety Information
Add Test ltem » Security Information

3. Select the appropriate Element type.
4. Select Edit = Save OR select the Save icon.

Note: Some Elements cannot be populated until you select the specific type for that Element. For
example, a Table Element in a Procedure Section can either be a Procedure, Decision, or Combined
Element.

Element | RiAs(0) | Metadata |

Title: |Table Type: |Tahle L]
Tahle

Decision Table

Procedure Table

roductory Combined Tahle

Sentence

Once a specific Type of the Element is selected, you cannot add Elements of the other Types. For
example, if Combined Table is used, you can only add additional Combined Table Elements if needed.
You cannot add a Decision or Procedure Table.
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File | Options

Resources Contents

Edit Exit Help

'm
| L-J

Create Section

Create Section from AIM Data
Create Element List from AIM Data
Search AIM Data

Add Element

Add Sub-Element

Add Note/Caution/Warning Element
Change Element Type

Rename Element

Copy Element

Paste Element

Resequence Elements

Storyboard

Copy

1l )| 8- ) mle|x

| Version

Status

1

4

Section Review
Fact-Image
Fact-List
Fact-Table
Decision Table
Procedure Table
Combined Table
Demonstration
Practice

Interaction

1.6.2.325

Deleting an Element

takes a few moments to update.

User Tip: Save often and be patient when in AIM LO MODULE. AIM LO MODULE quite often

1. Select the Element to delete.

Select the Delete icon.

3. Select the Yes button on the pop-up.

'

Learning Object Module v5.0

‘9) Are you sure you want to delete this Element?

Yes

No
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4.

Select the Save icon.

{esources

z/[a]

¥

User Tip: When deleting multiple Elements or Sub-Elements at one time, save between each

deletion to try and avoid crashing the software.

1.6.2.3.2.6 Resequencing an Element

User Tip: Save often and be patient when in AIM LO MODULE. AIM LO MODULE quite often

takes a few moments to update.

1. Select the Element containing the Elements to be resequenced.

2.

Select Options = Resequence Elements.

3. Onthe Procedure Element Resequence pop-up, drag the Element to the desired location.

No vk

f 14 _|Gloszary

[ Procedure Element Resequence: EM
Edit Exit Help
h{- Title Element | Inshuctor Actvity | Resources (1) | Meladata |
7 [Salely 2 Tille: [This locks Type: [Demonstration
3_[Secuity Information
5 [Fact | | =l = M _l_l
6 |Table |
7 _[Section Review
8 |Demonstration |
9 _|This Rocks |
10_|Section Review |
11 |Table
12 _|Practice
13 |Assessment

Select Edit - Save.
Repeat as needed.
Select Exit to return to the Course structure.
Select the Save icon.
iesources

?E!E.li
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1.6.2.3.2.7 Copying and Pasting an Element

User Tip: Save often and be patient when in AIM LO MODULE. AIM LO MODULE quite often
takes a few moments to update.

copied and pasted.

User Tip: You can copy and paste an Element (even with Sub-Elements) to another Section
or Lesson. When you copy and paste an Element, any related Sub-Elements and RIA are also

1. Select the Element to be copied.
2. Select Options = Copy Element.

JLNNE- 4

Create Course

Add Module to Course

Create Element List from AIM Data
Create Student Sheet From AIM Data
Search AIM Data

Add Element

Add Sub-Element

Add Note/Caution/Warning Element
Change Element Type

Rename Element

Copy Element

Paste Element
Resequence Elements
Storyboard

Copy

Create New Version

Delete

Dd...

it....
on
...

3. Select the Element prior to where the new Element should be added.

4. Select Options > Paste Element.

5. Select the Save icon.

iesources

ﬂﬂ}
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6. Change the new Element title or text as needed by clicking in the Title or text field and typing as

needed.

User Tip: Paste a copied Element multiple times by repeatedly selecting the Element prior to
where the new Element should be added, and then selecting Options = Paste Element.

1.6.2.3.2.8 Adding a Sub-Element
Select the Element or Sub-Element prior to where the new Sub-Element should be added.

[+]- A 3. Afloat Safety Guidelines
4. Ladders and Egresses
5. Damage Control
(-] 6. Ventilation
(=] a. Follow these safety guidelines
B
1. Atmosphere-supplying respirato
[+] 2. Air-purifying respirators remo
3. Federal regulation requires th
4. Each cartridge and canister is
c. Follow these safety guidelines
7. General Space Safety
8. Topside
9. Afloat Safety Guidelines Examples ...
10. Safety Color Codes and Signs for Ma...
il 41_Traininms

Select Options = Add Sub-Element - [Same Level or Lower Level].

file Resources Contents Edit Exit Help

[

— 1]

Create Course

5-| 8] plpls] B]x]

Add Module to Course

Create Element List from AIM Data Version | Statu

Add Element » pentals % 1
il 1
Add Sub-Element » Same Level
Add Note/Caution/Warning Element 4 Lower Level I
L}
Copy Element
Paste Element 1 I
il [}
Resequence Elements 1 H
Storyboard
Copy G 1
on
Delete bgram
elines
Add Test Item » Bes
Modify/View Test Item
Delete Test Item afaty guidelines
|£m. o]
ISD Considerations le-supplying respirato
p respirators remo
Find Course ulation requires th
dge and canister is
Check Spelling faty guidalines

Show In Use Information y

Reset In-Use elines Examples ...
s and Signs for Ma
Explain Flag .
Remiove Flag ibilities
X [ Practice
B 14. Section Review
| [ Assessment
[+} Summary
[+} O 4. Luis Ahvarado 1 |
[+ (3 5 Marie Lohman 1 1
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e Select the Type: drop-down menu and select Sub-Element (Text).

Element | RIAs(0) | Metadata | ‘
Title: I?-b Type: |Sub-Element LJI

Sub-Element
Sub-Element (Image’
Sub-Element (Text)

Note: Sub-Elements can be resequenced, deleted, or copied and pasted in the same way that Elements

are.

1.6.2.3.3 Populating the Element Tabs

When populating the Element or Sub-Element’s Element tab, content is entered into the open text field.

Element | RIAs(0) | Metadata |
Title: |Jntroduction Type: |Introduction

IﬁmesNewRoman ﬂ I12 ﬂ B | flgl §EIEE|

m

All DP text should be entered into the text field to match the As-Is LP as closely as possible. Use the
following guidelines when entering content:

e Content should not be reorganized or rewritten from the current Courseware.
e The following changes are the only modifications that can and should be made to the

content:
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Correct spelling.

Correct obvious grammar issues.
Correct obvious punctuation issues.
Correct general capitalization issues.

© oo oW

Correct any references to TG Sheets to remove the numbering from the TG Sheet. This is
because the numbering will be different after the TG Sheets are migrated to LO Module.
Also, the numbering will change every time the structure of the Course changes. Since
TG Sheet references are not linked in DPs, the numbers should be removed to avoid
incorrect numbering.
i. For example, Assignment Sheet 3-2-4-1, Supply Security Administration,
should be entered as Assignment Sheet, Supply Security Administration.

Note: In making these corrections, you should not reword the content in any way, even if it is to make
the content clearer.

e If there is no content for a particular required Element type, enter [Content not available].
a. The Learning Center will need to provide content for these Elements if required.
e If there are optional Element types that are not used, they should be deleted.
e |f an entire Section has no As-Is content, enter [Content not available] for each Element in the
Section structure.
a. The Learning Center will need to provide content for the Section if required.

User Tip: LO Module can have problems with formatted text that is copied and pasted into
fields. To avoid this, copy the text into Notepad, and then cut and paste the Notepad text
into LO Module.

When pasting large chunks of DP text into the Element tab. It is best to paste it all into
Notepad at once and manipulate it there prior to pasting into LO Module.

1.6.2.3.4 Completing RIA Tabs

Information in the RIAs tab provides guidance to the instructor on the structure of the Lesson and
specific actions to take, such as displaying CAl screens, selecting hyperlinks, and directing trainees to TG
sheets. The information found in the RIA tab aligns with the information found in the RIA heading of the
LP.
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Element | RiAs(3) | Metadata |

Source

Type | Text I
Free Text Directtrainees to complete the End-of-Lesson Assessment.

Free Text Monitor trainee progress.

Free Text If the trainee is unsuccessful after two atterpts, work directly wit...

UNCLASSIFIED
LESSON PLAN

SECTION: (U) Network Models

DISCUSSION POINT RELATED INSTRUCTOR ACTIVITY

(U) Incorporate integnity discussions into the course by
personalization of a personal experience. denved from Force
Operational Notes (FON). lessons leamed. rate conferences.
or other germane source.

[ &

(U) OSI Reference Model
3. (U) TCP/P Stack

4. (U) OSI Versus TCP/1P

5. (U) End-of-Lesson Assessment 5. (U) Direct trainees to complete the End-of-Lesson
Assessment.

(U) Monitor trainee progress.

(U) If the trainee is unsuccessful after two attempts, work
directly with the trainee to ensure comprehension.

The RIAs tab functions include:

e Add Resource
e Add Graphic
e Add Sheet

e Add Fault

e Add Free Text
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Contents Edit Exit

Add Resource
Add Graphic
Add Sheet

c Add Fault
Add Free Text

ILl==1

|

In this project, we will only be using the Add Resource, Add Sheet, Add Fault, and Add Free Text
functions.

Follow the below guidelines when entering RIA in the RIA tab:

e AllRIAs are added exactly as they appear in the As-Is Courseware.

e Ensure the RIA lines up with the corresponding DP.
0 To do this, you may have to add extra hard returns or Free Text RIA since the Sub-

Element levels are not built out to separate all of the DPs.

Element | RlAs(l) | Metadata |

Source
Type | Text
Free Text 2.Page 1 of5.a. Page 2 of 5.b. Page 3 of 5.c. Page 4 of 5.d. Page 5 of 5.

Before Text

Free Text|2 Page 1 of 5.
a Page 2 of 5.
b. Page 3 of 5.

c. Page 4 of 5.
d. Page 5 of 5.

0 Use the Print Preview of the LP to ensure the RIAs are lined up appropriately.

Page 84 of 171



Content Build and Migration in Support of Sailor 2025 SOP

21 December 2016

I @.F ﬁll(Enler search criteri

Web

Developer

Student

Web with Storyboard

LP
Sheet

e I U TV U T P pgr—

r QOrientation

" Faorrait

@ Landscap
o

=

[~ Print'Page x of ¥

Setup Header,’FDDterl

rr Exclude Sel-Paced Sections

—

~Main DP Printing Options

" DF perPage
e %

~DP Spacing
MNumber of blank lines between I 1

I"—"g\?‘er‘rl“de specimec L

Srharinm

Conce! |

b.  (U) 2. Introduction to Postal Service

a. Introduction to Lesson
b. Objective(s)

c. Think About It

d. What to Expect

(U) 2. Page 1 of 5.

a. Page 2 of 5.
b. Page 3 of 5.
c. Page 4 of 5.
d. Page 5 of 5.

You can also accomplish the same spacing by using separate Free Text RIAs for each time you need an

extra space.
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Element | RlAs(2) | Metadata |

Source
Type | Text
Free Text 2.Page 1 of5.
Free Text a Page 2 of 5.b. Page 3 of 5.c. Page 4 of 5.d. Page 5 of 5.
Before Text
Free Text|a Page 2 of 5.
h. Page 3 of 5.
c. Page 4 of 5.
d. Page 5 of 5.

b. (U) 2. Introduction to Postal Service b. (U) 2. Page 1 of 5.
a. Introduction to Lesson (U) a. Page 2 of 5.
b. Objective(s) b. Page 3 of 5.

c. Think About It c. Page 4 of 5.
d. What to Expect d. Page 5 of 5.

e The only changes that can and should be made are to correct:
0 Spelling and punctuation.
0 TG sheet numbers. This will be automatically corrected by linking the sheets in the RIA.
0 Reference titles.
e If aresource is in the RIA that cannot be verified or tied to a TG Sheet or reference in the RRL,
add [Reference not available] next to the resource.

In this example, there are no TG Sheets that can be matched to the generic reference to a “Job Aid”.
Therefore, [Reference not available] was added.
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Free Text|a Page 2 of 5.
b. Page 3 of 5.
c. Page 4 of 5.
d. Page 5 of 5. Job Aid [Reference not available].

e If a PowerPoint is being converted into an LP, it will not have any RIA entered.

User Tip: LO Module can have problems with formatted text that is copied and pasted into
fields. To avoid this, copy the text into Notepad, and then cut and paste the Notepad text
into LO Module.

When pasting large chunks of RIA text into the Element tab. It is best to paste it all into
Notepad at once and manipulate it there prior to pasting into LO Module.

1.6.2.3.4.1 Add Resource

Resources include any reference materials or classroom materials needed to teach the Lesson
effectively. All resources added to the Lesson will come from the RRL. This is a list of materials that the
schoolhouse is required to have available for the instructor and trainees to complete the Lesson. You
will pull directly from the RRL to add resources. If a resource is not listed when you attempt to add it,
refer to the Error! Reference source not found. Section for instructions on how to add resources to the
RRL.

To add a resource:

1. Select the RIAs tab next to the corresponding Element tab.

Element | RlAs(0) | Metadata |

Source

Type | Text
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2. Select Resources = Add Resource.

_-‘F

nBERPRRRRRRBRER
m

Al
All

Cao
Co
Co

IDI
Int
Int
ISI
Ne
Pe
Mc
+

(4 [Ty TE R ANTE < anAr S WEFATT

Add Graphic
Add Sheet
Add Fault
Add Free Text

Delete Resource

Copy Resource

Paste Resource

View IETM Structure
Launch/View IETM
View RRL

Display Media
Modify/View Fault

3. A pop-up window appears. Choose the type of resource from Resources.

Options | Resources | Contents Edit Bxt
I | 2|0 Add Resource
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—

[ Resources | Edit

Exit Help

d Calibration

Computers

Equipment
Equipment R
Films

Hand Tools
IETM

MM

Ordnance

S B AW AN AN AN N AN AN A_.a = E_a

Photographs
Prefaulted

Consumables

Maintenance Trainers

Miscellaneous Materials

efurbished

v Publications

Slides
Software

Special Tools

Support Equipment
Test Equipment
Training Devices
Training Equipment
Training Materials

Transparencies

4. Double click on the resource.

Find: |<Enter search criteria here>

Find All I

VI Equipment

Videos

Wall Charts
p
D e e (=] © i)
Options Resources Edit Exit Help

Sel

Document Title

Document Number

Stat «

Receipt Checklist

NPPSC 132042

Receipts

Standard Operating Proced

Record of Emergency Data

NAVPERS 1070/602

Recruiter Division Command

1306-954

Recruiter Duty

1306-964

Reenlistments

Standard Operating Proced

Refrigerant Monitor, Paraser

Religious Program Specialis

59514-FL-MMA-010

NAVEDTRA 14227B

=

2| 01000000

Religious Ministry Support ¥ SECNAVINST 1730.7D

R

INAYPERS 1300/16

010
4

\ — /
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User Tip: Type all or part of the resource title in the Find text box for faster searching.

Note: If a resource isn’t in the Site RRL list, refer to the Section on how to add resources to the RRL here.

Note: If there is an RIA for a resource that is not specific, but something that would be needed to teach
the Lesson, it should be added to the RRL in the Title field for Publications. In the Doc Number field,
enter [Reference not available]. For example, Applicable MRC’s would be entered as:

Title: Applicable MRC'’s
Doc Number: [Reference not available]

5. Select Edit = Save.
6. Add Before Text and After Text, as applicable.

Element | RlAs(l) | Metadata
Source

Type Tesd

Naval Military Personnel Manusl (MILPERSMAN]. NAVPERS .

Before Text j
BRL [Naval Military Personnel Manual (MILFERSMAN), NAVPERS 15860 =~

Wolume | Partl
b Part Type I ,I I
itation Type -] Connection -]
Adter Text -

7. Select Edit = Save OR select the Save icon.

1.6.2.3.4.1.1.1 Before Text
The Before Text drop-down menu contains most of the standard text. If you need text that is not within

the drop-down menu, you may type it in the Before Text field.
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Element | Rlas(l) | Metadata |

Source

Type |Text

Publication  Receipt Checklist NPPSC 1320/2.

Before Tex

sl

Demonstrate

Demaonstrate operation of
Demaonstrate use of
Volume | Direct frainee to
Directtrainee to operate the
b Pan Type|Direct trainee to perfarm
Discuss

Display E-

RRL

m

After Text

If you do not add After Text, a period is placed at the end of the resource automatically to create a

sentence.

2. Refer trainee to Naval Military Personnel Manual
(MILPERSMAN), NAVPERS 15560 (series).

If you do add After Text, a comma is placed at the end of the resource automatically to correctly

punctuate a sentence.

Reference Naval Military Personnel Manual
(MILPERSMAN), NAVPERS 15560 (series), for additional
information to teach this discussion point

1.6.2.3.4.2 Add Sheet

TG sheets are linked in the RIAs tab. When providing the instructor with a command (e.g., Refer trainees
to [TG sheet type, number, and title].)you will use the Add Sheet feature to link the TG sheet. You will
not be able to add this RIA until the sheet is created in the Sheets tab at the Section level.

Note: Sheet numbers will be created by the order in which they are linked within the Section, not by the
order in which they are listed in the Sheets tab. Therefore, sheets should be linked in the order in which
they are referenced within the Section. If they are not linked in order, the RIA will contain different
sheet numbers than the sheet numbers in the TG.

To link a sheet:

1. Select Resources > Add Sheet.
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Options | Resources | Contents Edit Exit

o B [E Add Resource

1BEDRBRRBRBRRER

i

-
-

Add Graphic
Add Sheet
A- Add Fault
All
: Add Free Text
AN
Co Delete Resource
Co
CD Copy Resource
=
DI Paste Resource
Im‘i View IETM Structure
Int/
ISI Launch/View IETM
Ne View RRL
Pe .
| splay M
M¢ Display Media

[+ Modify/View Fault

(PR it et (el ekl ol ada s = e e

2. A pop-up window with all sheets from that Section appears. Select the appropriate sheet.

B3 Student Sheets
>

Options  Select Exit Help

- - ed ‘

5.

|[Outline
Information

|[Travel Claims
Types of Travel Claims

Information

Travel Claim Forms

Problem

Travel Claims Progress Check

Travel Claims Process

Information

Travel Claims Instructor Demonstration

2
3
4
5 Diagram
6
7

Job

Travel Claims Practical Exercise

Note: The text that displays in AIM LO Module (e.g., Types of Travel Claims) is different from the text
that will display when the LP is exported (e.g., Information Sheet 7-2) It usually updates after the
updates are saved in AIM LO Module; however, if it does not, do not be alarmed.
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Element | Rias(l) | Metedats |
Sourca

Text
Types of Travel Claims.

Vi
StudentSheet

2.  Information Sheet 7-2.

Belore Tent| .

Student| Tvpes of Travel Claims

Adter Text |

Note: Sheet numbers update automatically after a sheet is added or deleted.

3. Enter Before Text as necessary.

Before Text [FEENEHEIE =]
B

Pre| th

Sudent|pefbrip
Refer to and directtrainee to refer to
Referto the

Refertrainee to
Reference =

Show
After Text Use I_v

4. Enter “, [Sheet Title].” in the After Text field to complete the sheet title in the LP.

Element | RiAs(l) | Metadata |
Source

Type I Text
StudentSheet  Refer trainee to Types of Travel Claims, Types of Travel Clai...

Before Text|Refer trainee to ;]
Student |Types of Travel Claims m
After Text| Types of Travel Claims| n

It appears redundant in AIM LO Module; however, the LP export appears correctly. Eventually, it
will update in the RIAs tab to read correctly.

2. Refer trainee to Information Sheet 7-2, Types of Travel
Claims.
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5. Add additional After Text as necessary.
6. Select Edit > Save OR select the Save icon.

1.6.2.3.4.3 Add Fault

Faults are linked in the RIAs tab. Faults input are reflected in a Fault Applicability List and table created
at the bottom of the LP, which identifies to the instructor specific fault content (i.e., Equipment effected,
Function Faulted, Fault No and Document associated with fault).

1. Select Resource = Add Fault.

File Options Illsaun:es Contents Edit Exit Help

up | Add Resource
Add Graphic

Te | Add Sheet

-0 Ab

m affire Add Fault

o G A = riReprof
[ I__fl AN Add Free Text rfRepﬂ}{
&-E0 AN

& Ch AN Delete Resource DBOX
-3 AN

B & AN Copy Resource

& AN Paste Resource SANDB!
& O AN =

E-E AN View [ETM Structure

[+ '_J Bt Launch/View IETM ance of
E-G8 Baf o /SQQ-
5 & Bal View RRL NS00
# 1 Bat Display Media AN/SQQ-
o !-_I EEE Modify/View Fault /500~
[ |__'| Bat - NISQQ-

2. A pop-up window displaying the Function Faulted from that Section appears.

r -
15 Function Faulted IR - (=l e
Options  Exit Help
Sel |Function Faulted Fault No. Security Marking Type
| |
Il >
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3. Input the appropriate fault by selecting “Options” from the Function Faulted sheet, then select
“Create” from the drop down menu.

[y Function Faulted — - — penii=]
Options | Bxit_Help _
Select Fault No. Secuily Marking | Type |
Unselect ]
Create | ]l
1'

Modify

Delete

Secunty Marking

4. A Fault Contents popup appears. Required fields include: Function Faulted, Fault No., Type and
Required Y/N.

L
Function Fau B8] R
= s Faute € (=1 e
Options Bt H
]| Options Exit Help
Sel | Function | Type

|_Function Fauled |[Function Faulted Required)

|_Faut No. | (Fault No. Required)
Required (Y/N) Py
U Eml

Dmment‘

5. From the LP retrieve information specific to the fault, and in the Faults Contents popup,
complete the required fields.
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'i

Function Faul
2 [y Fault Contents
Options - Bt - -
Options  Exit Help

Sel |Funclion : 1
IFln:hnnFuM S Display Fault

'3 Function F = e 8 =
%a Fault Contents
Options Bt
‘ Options]_Ext JHelp
Sel |Function
Funchon Fauled [CDS Display Fault
: Faut No [34C104-R-005
' T59% [Contiolled  ~
Reased 70 ? ER ]
4 Equpment
Document
4

7. From the Function Faulted list, double click the Sel field to place an X in front of the fault to
select.

—— = :
&) Function Faulted , Lol 50
Options  Exit Help

Sel |Function Faulted Fault No. Security Marking Type
X CDS Display Fault 34C104-4-0C (U) Controlled
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8. Select Exit from the Function Faulted list popup to close the window.

® DS Display Faull

9. The Fault RIA appears in the list of RIAs.

Element | Rlas(8) | Metadsta |

Source

Type l Text l
Free Test Display side 4-3-1-1.

Free Text Display side 4-31-2

Free Test Display side 4-3-1:3.

Free Text Display side 4-3-14.

Free Text Display side 4-3-15.

10. From the RIA Section, add in any applicable “Before Text” and or “After Text”.
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Elemert | FlAs®) | Metadats |

Source
| Type | Tex |
Free Test Daplay shde 4-31-1
Free Test Duplay shde 4312
Free Test Duplay shde 4-31-3
Free Test Display side 4314
Froe Test Daglay shde 4315
Student Sheet Reler biarme 10 Job Sheet 1-1, Job Sheet 1, AN/SQ0-J4CIVI2 FAULT ISOLATION
Fauk Irest CDS Display Fault, 34C104R-004
Faul Insent CDS Boot Dive Fault. 3801048002
Belore Tewt R
Fod COS Daplay Fauk. 3801048004
Al Test

1.6.2.3.4.4 Add Free Text

The remaining RIAs are entered via Free Text (i.e., any RIAs that do not include linking a sheet or

resource).

1. Select Resources = Add Free Text.
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Options |Rsourcs| Contents Edit  Exit

‘|[§“||j Add Resource

i Ak

Add Graphic

Add Sheet ]
A< AddFault c
i:! Add Free Text

Delete Resource

CCJ, Copy Resource

Paste Resource
IDI

View IETM Structure
ISI; Launch/View IETM
Ne View RRL

TBRERRERRBRRRE
m

MC! Display Media

5: Modify/View Fault 3|

2. Select a command from the Before Text drop-down menu. If you need text that is not within the

drop-down menu, you may type it in the Before Text field.

Element | RIAs(1) | Metadata |

Source
Type | Text
Free Text Display Textis required.
Before Text [BIFIEY |
Free Text =t (<]
Distribute
Draw
Insert
Prepare the E
Referto
Refer to and direct trainee to refer to
Referto the E

3. Type the remaining RIA text in the Free Text field.
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Element | RIAs(1) | Metadate |

Source

Type I Text

Free Text Display CAl screen 2 of 10, Travel Claims.
Before Text [Display

IFﬂ?e Text|CAl screen 2 of 10, Travel Claims)|

4. Select Edit = Save OR select the Save icon.

SECTION: Afloat Safety

DISCUSSION POINT RELATED INSTRUCTOR ACTIVITY

10.  Safety Color Codes and Signs for Marking Physical Hazards § 10.  Display CAI screen 3 of 5. Safety Color Codes and Signs for
Marking Physical Hazards.

Refer to Navy Safety and Occupational Health (SOH)
Program Manual for Forces Afloat. Volume II. Surface Ship
Safety Standards. OPNAVINST 5100.19 (series). Chapter
C1. Basic Safety. for additional information.

a. Refer trainees to Information Sheet 6. Safety Color

Color codes and signs include: A ! :
Codes and Signs for Marking Physical Hazards.

(1) DANGER
(a) Red is the color for the identification of (a)  Operational Forces Supply Procedures.
dangerous equipment or situations. NAVSUP P-485, Volume II. Supply

ppendices.

(b)  Safety cans or other approved portable
containers of flammable liquids are
painted red with some additional visible
identification ¢ither in the form of a
yellow band around the can or the name
of the contents stenciled or painted on the
can in yellow.

1.6.2.3.5 Organizing PowerPoint Content into AIM LO Module Elements
When a Course has no LP and is taught via PowerPoints, an LP is created using the content within the
PowerPoint. PowerPoints will be entered similarly to Sections with LPs.

1. Locate the current content.
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Find the content that corresponds to the Sections in AIM LO Module.
Refer to the Content Type to determine the Element types that correspond to the content type.
Look at each of the slides and determine which Element type it fits.

vk W

Ensure that all required Elements are used. If there is a required Element that does not have
content from the PowerPoint that fits the Element type, enter “[Content not available]” next to
the Element type.

6. Ensure the PowerPoint Slides are all utilized and are not rearranged.

7. Ensure the slides are listed in the order in which they appear in the PowerPoint.

8. If there are multiple PowerPoint presentations used to build a Section, enter them in the order
in which the content is listed on the content mapping document.

1.6.2.3.5.1 Element Structure
The Element structure for PowerPoints being converted into LPs will follow the same structure
guidelines as Courses with As-Is LPs.

If there is only one As-Is Topic aligned to the To-Be Section, an Element will be created for each
PowerPoint slide. The on-screen content and notes within the PowerPoint slide will be combined and
entered within the Element level Element tab. No Sub-Elements will be used.

If there are multiple As-Is Topics merged into the To-Be Section, An Element will be created for each
Topic title. Underneath the Topic title a Sub-Element will be created for each PowerPoint slide within
the Topic. The on-screen content and notes within the PowerPoint slide will be combined and entered
within the Sub-Element level Element tab. No further Sub-Element levels will be used.

1.6.2.3.5.2 Title Slides
Title slides are entered as the Introduction Element. The content for this Element is in the slide notes
Section. The slide notes should be entered as sub-Elements under the Introduction Element.
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Religious Program Specialist — A School

Pastoral Care Support
Confidentiality and Privileged Communication

INTRODUCTION:

As a Navy Chaplain you will need to know the tools used by the service’s leadership to establish its course and direction on many vital

DISCUSSION POINT RELATED INSTRUCTOR ACTIVITY

1. (U) Introduction

(U) As a Navy Chaplain you will need to know the tools
used by the service's leadership to establish its course and
direction on many vital 1ssues.

To assist you 1n navigating the sea of policy and doctrine we
will provide an introduction to the form and layout of these
documents. Additionally, we will take a close look into
those policies that have a direct bearing on you ministry
directly with the men and women, and their families. m your
unit.

The policies we will look at are not the only ones that will
need to be familiar to you. They are the most basic function

of chaplain ministries.

Let's look at the objective we will cover in this material.

1.6.2.3.5.3  Slides with Content and Slide Notes
Slides that have content on-screen and in the notes should be organized to merge the two. Some may
be simple, because the on-screen content is repeated in the slide notes.

Example 1
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Terminal Objective

« MAINTAIN privileged communication and
confidentiality

UNCLASSIFIED 2 A-561-0002

The terminal objective are:
MAINTAIN privileged communication and confidentiality.

Are there any questions before we begin?

In this example, the on-screen content can be ignored, and the slide notes can be entered as sub-
Elements to the Terminal Objective Element.

Example 2

In other instances, the on-screen content does not match the slide notes. In these cases, the content
must be analyzed to determine the best place to place the slide notes in conjunction with the on-screen
content. In the following example, the slide notes would work best as a sub-Element after the two bullet
points in the on-screen content.
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Some History

* The U. S. Supreme Court — Trammel v. US

» The Court recognized the existence of “priest-
penitent” privilege in federal common law, “to
disclose to a spiritual counsel, in total and absolute*
confidence, what are believed to be flawed acts or
thoughts and to receive priestly consolation and
guidance in return.”

UNCLASSIFIED 7 A-561-0002

The Supreme Court was saying they accepted and gave credence to something that was a part of federal law, though not codified formally.
The courts value confidentiality so much they consider it protected under the law.
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DISCUSSION POINT

3.

(U) Some History

(U) The U.S. Supreme Court - Trammel v. US

The Course recognized the existence of "pniest-penitent”
privilege in federal common law, "to disclose to a
spiritual counsel. 1n total and absolute* confidence, what
are believed to be flawed acts or thoughts and to receive
priestly consolation and guidance in return."”

The Supreme Court was saying they accepted and gave
credence to something that was a part of federal law, though
not codified formally.

The courts value confidentiality so much they consider 1t
protected under the law.

RELATED INSTRUCTOR ACTIVITY

Example 3

In this example, the Slide notes are best merged with the appropriate bullets within the on-screen

content.
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Some History

1813 — New York John People
« 1825 — New York People v. Smith
« 1828 — New York All Christian Clergy

* 1962 - New York Rabbis and clergypersons of
recognized denominations
were included by the
legislature

UNCLASSIFIED b A-561-0002
—_—_—_—_—_—_———

In 1813 a Roman Catholic priest heard the confession of John People who was accused of stealing goods from another man. Asis Roman
Catholic teaching, when it comes to stealing, restitution in some form is required in addition to the penance. When John People returned
the stolen goods, he was arrested and charged with theft.

The priest was ordered to testify, refused, but was without any legal protection. In People v. Phillips, the New York state court of appeals
ruled that communications shard in the course of confession were and should remain beyond the reach of the courts on the grounds of
religious liberty.

In 1825 an Episcopal clergyman was not so lucky. The court refused to recognize any privilege for Protestant clergy.
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DISCUSSION POINT

3

(U) Some History
(U) 1813 - New York John People

In 1813 a Roman Catholic priest heard the confession of
John People who was accused of stealing goods from
another man. As i1s Roman Catholic teaching, when it
comes to stealing, restitution in some form is required in
addition to the penance. When John People returned the
stolen goods. he was arrested and charged with theft.

The priest was ordered to testify. refused. but was without
any legal protection. In People v. Phillips, the New York
state court of appeals ruled that communications shard in the
course of confession were and should remain beyond the
reach of the courts on the grounds of religious liberty.

1825 - New York People v. Smuth

In 1825 an Episcopal clergyman was not so lucky. The court
refused to recognize any privilege for Protestant clergy.

1828 - New York All Christian Clergy
1962 - New York Rabbis and clergypersons of
recognized denominations were included by the legislature

RELATED INSTRUCTOR ACTIVITY

1.6.2.3.5.4 Slides with Images and No Content
Since images are not entered in the LP, a slide with no content will have [Content not available] entered.
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Hospital Calls

IMM # 3-1-29

23. Hospital Calls

a. [Content Not Available]

1.6.2.4 Add TG Sheets

The TG is developed in the AIM LO Module by adding instructions sheets at the Section level. Each TG
sheet is used within certain Elements in a Section and each serves a specific purpose. There are six types
of instruction sheets:

e Qutline
e Information

e Diagram
e Problem
e Job

e Assignment
To add a TG sheet:

1. Select the Section to which the TG sheet should be added.
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2. Select Sheets = Add Sheet = [type of sheet].

File Options Resowrces | Sheets | Contents

Edit Exit Help

e o 0 - =1 Add Sheet Assignment | o] e8| -]
Delete Sheet Diagram
MTee | Copy Sheet | Infarmation ks Dawsed
=] Modules Job
"I 1. ES0S E e 1 021072018
N 2 CSCSIC A School Sandbox Outline i 04/17/2014
= Lessons Problem
SR 1, Aairee Reyes —_— faz201s
2. Brooke Davs i [ 031672015
=} 0 3. Carcl Wise 1 [ oaz1201s
+ | Owrvew
= Sections
BR=] 1 Afioat Safety | i 0172972018
-] [ 1. Section Introduction 05/04/2015
s| [0 a This section covers the foll 050472014
H 2. The Navy SOH Program 05/04/2014

The TG sheet appears in the viewing window in the Sheets tab.

When entering content into TG Sheets:

1. Enter content exactly as it appears in the As-Is TG sheets.

2. The only changes that can and should be made are:

a.

b
C.
d

Correct spelling.

Correct obvious grammar issues.
Correct obvious punctuation issues.
Correct general capitalization issues.

Note: In making these corrections, you should not reword the content in any way, even if it is to make
the content clearer.

1.6.2.4.1 Add Content to a TG Sheet
Each type of instruction sheet includes various fields that require completion. The type and number of
fields that require completion vary based on the type of instruction sheet.

Note: Objectives are not manually entered in TG sheets. AIM LO Module autopopulates all Objectives.

To add content to a TG sheet:
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1. Select the Section.

File Options Resources Sheets Contents Edit Ext Help
IE‘ | [E] EIEI ﬂlﬁ' : E_'Ij @j@l olm|R| =] x| sl &Iﬂ O |[<Enter search criteria here>  Find | Clear |
| Title | Ver~|  General | JDTA | Info | Sheets | Resources | Metadata |
- Interior Communications (IC) A School Modules March 2013
[#- [ 18D Tools Title
[N Logistics Specialist "A" School -
1 NETC Training Content Project (Sailor 2025 Version) 01 OC... 153 Up & Blank Microsoft Word Dacument
[ [0 MNew Object
[+ New Object Identification Number
- Personnel Specialist "A” School [4bc1e8e1d1b64593bccdbBd0EA0E1 9
[+ (21 Personnel Specialist Job Sheets e
#- [ Radar Module December 2013 Ensling (hjecivs Slalemers
= ] Religious Program (RP) "A" Course (2015) J GIVEN APPLICABLE SOFTWARE. DOCUMENTATION, AND DIRECTIVES SET UP ABLANK -
| [ Modules MICROSOFT® WORD DOCUMENT TO 100% ACCURACY law DOCUMENTATION AND
= Cﬂ 1. Microsoft® Office Suite DIRECTIVES o
- [=} Lessons
- 1. Create a Microsofi® Word Document Section type [p, = =] - Time fin minutes)
[+ Overview ocedur
El Sections Instruction Ty [ingiuotor Led | Class o
oR=] P
- 2 Format Text in a Microsoft® W. . Status [jncomplete ~] .
- [ 3. Insert a Graphic in a Microsoft... PA IU—'
[#- [ 4. Insert a Table in a Microsoft® . |
EI Summary ;I
Bold items are mandatory NSCORM 2004 4th ed

2. Select the Sheets tab.

Eile

s alole) ] B i) 81 2 1o 9 ) olole) whx) w1 Q-] o g | o |

Options Besources Sheets Contents Edit

Tile
[ " Interior Communications (IC) A Scheol Medules March 2013
& 3 15D Tools
[ Logistics Specialist "A" School
£ METC Training Content Project (Sailor 2025 Version) 01 OC...
[#- 3 Mew Object
[+ Mew Object
& A Personnal Specialist "A” Schogl
[+ [ Personnel Specialist Job Sheets
[+ £ Radar Module December 2013
B Religious Program (RP) "A” Course (2015)
= Maodules
= £ 1. Microsoft® Office Suite
=} Lessons
= 0 1. Create a Microsoft® Word Documant
1 Ovenview
[l Sections
GE=1 1 Set Up a Blank Microsoft® Wor
=B 2 an'nai Text in a Microsoft® W,
-3 3. Insent a Graphic in a Microsoft
- [ 4. Insen a Table in a Microsof® ..
[+ Summary

[Vera]  General | JOTA | Inio [Shects | Resouces | Metadata |
Source
1 Dlutiine Sat Up & Blank Meciozoft® W _
2 Infoemiation Mac1osolt® Word Ribbons 2nd Tabs
3 Drimguaen Mizacolt® 'Wioid Ribbors and Tabs
4 Problsm Mizrozolt® wWiord Ribbons and Tabes - Activity
5 Infeematian Set Up & Blank Maaosalt® Document - Procedue
3 Probbam Set Up a Blank Macaorolt® Document - Activiy
i
=
Bold teens se mandstony NSCORM 2004 4th ed

3. Double-click the sheet to complete. A pop-

up window appears.
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Sheet Title™

Introduction®

B3 Information Sheet
Options  Contents  Exit Help

=)= el

Microsoft® Word Ribbons and Tabs

[Introduction Required]

* Fields are required

4. Complete the Title and Introduction fields. All types of instruction sheets, other than the diagram

sheet, have Title and Introduction fields. If the As-Is content does not include an introduction, enter

“[Content not available]”

" in the Introduction field.
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[ Information Sheet EI@

Options  Contents  Exit Help

Sheet Title” |Microsoft® Word Ribbons and Tabs

Introduction™ |The purposze of this information sheet iz to provide you with information
regarding Microzoft® Word ribbons and tabs.

* Fields are required

Note: TG Sheet titles should always be written in title case. Do not enter Sheet Titles in all caps.

5. Select the Contents drop-down menu. All types of instruction sheets, other than the diagram
sheet, have a Contents drop-down menu. Each instruction sheet has various fields in its
Contents drop-down menu.
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& Information Sheet

Options | Contents

[E=8 EoB ==

Bxit Help

Sheet T

References ons and Tabs

Infermaticn

Introduction®

* Fields are required

The purpose of this information sheet is to provide you with information
regarding Microsoft® Word ribbons and tabs. |

6. Complete the fields in the Contents drop-down menu. Each type of instruction sheet includes

various fields that require completion. Select each field, one-by-one, and complete it. Below is a

list of instruction sheets and the corresponding fields in the Contents drop-down menu.

Sheet

Contents Fields

Section Outline

el References

Diagram
Problem

Assignment

Information
Diagram
Equipment
References
Direction
Problem
Answer
Equipment
References
Self-Test
Questions
Safety
Precautions
Job Steps
Answer
Study
Assignments
Study Questions

Description
Provide a numbered list of Section Elements (Microsoft® Word).
Select relevant references from the RRL.
Provide the primary contents (Microsoft® Word).
Insert the diagram (Microsoft® Word).
Select relevant equipment from the RRL.
Select relevant references from the RRL.
Provide directions for completing the activity (Microsoft® Word).
Provide the primary activity contents (Microsoft® Word).
Not added at this time.
Select relevant equipment from the RRL.
Select relevant references from the RRL.
Provide self-test questions to ask when performing job steps
(Microsoft® Word).
Provide safety precautions to consider when performing job steps
(Microsoft® Word).
Provide job steps to perform (Microsoft® Word).
Not added at this time.
Provide directions for completing the assignment (Microsoft® Word).

Provide the primary assignment questions (Microsoft® Word).
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_ Answer Not added at this time.

1.6.2.4.1.1 Add References to a TG Sheet
To add references to a TG sheet:

1. Select Contents = References.

fr \The ng 18 & list of , abbreviatons, and key lamme uead in this

*Fields ase required

2. Select Options > Add.

Shaat] D3 Sheet Refe
Options | Exit_Help
Add
Intriha Delete
View RAL
View [ETM Struciure
Launch/View [ETM

Aftar T

Select Reference for Document
Select [ETM for Document
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3. When the number appears in the Seq. column, select Options = Select Reference for
Document.

( [ Sheet References —— " = ]
(Optiows| ext_Help : :
Add ..
Delete

View REL

Struciure
ow [ETM

View [E

Launch/

Select Reference for Document
Select IETM for Document

e =

4. Double-click the appropriate document.

(5 select site RRL ] -l . g@l@n
Options Select Exit Help - S—
Find: |<Enter search criteria here> Find All EIF

Document Title Document Number Stat  « 1
Office of Personnel M Fi int Card. Sta 2 C ia
Office of Personnel M ement Fingerprint Card. Sta 3 [ \m
Office of the Chief of Naval Operations (OPNAV) Instru [OPNAVINST 4790.4 (series) [ 1
Office of the Chief of Naval Op i Li Blank C 1
Office of the S ry of Defi L head Blank C 1
Qil Content Monitor Technical Manual NAVSEA 59593-CD-MMO-010 [5 1
One Touch Support (0TS) C 1
Op ion and Mail Cathodic Protection Syst |Unified Facilities Criteria (UFC) 3-570-06 C i
Operational Forces Supply Procedures NAVSUP P-485. Volume |, Operational Forces Sup| C 1
Operational Forces Supply Procedures NAYSUP P-405. Volume II. Supply Appendices C 1
Op i Risk OPNAVINST 3500.39C (series) C i
Operational Si ing Systems (0SS) NAVSEAINST 4790.7B (series) [ 1
Order for ies or Services DD Form 1155 C 1
Order of Precedence of Members of Armed Forces of |DODD 1005.8 [5 _‘ |
Or ization of Marine Corps Forces MCRP 5-12D C |1
Organizational Mai M System-Ne> [(OMMS-NG) [5 i
Page 4 NAVPERS 1070/604 C T
Part-task Training Device Simulation User's Guide  |[TBD [ {1
Part-task Training Device Technical Manual TBD C 1
= R tion R NPPSC 465071 c {1
= ger R tion Request (PRR) NPPSC 4650.8 C |

\ Ef‘ml Squadron Thirty Instruction VP30INST 1000.1H C L‘ —

I. i T : RS A0 51 =

T T _

User Tip: Select the references in alphabetical order by title, as references cannot be
resequenced once they have been added to a TG sheet.
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5. Repeat the above steps as necessary to add all references.

Note: If a reference is not in the RRL to select, refer to Section 1.6.1.1 Adding Items to Site Resource
Requirements List (RRL). If a reference in the As-Is TG Sheet is not a specific reference with a title

and a document number, enter the reference in the title field and enter [Reference not available] in

the document number field. For example, Applicable MRC’s would be entered in the RRL as follows:

Title: Applicable MRC's

Doc Number: [Reference no available]

6. Select Exit to close the Sheet References pop-up.

WHIAD  UERETER | CAIL PRI

L

Ehaet] C3 Sheet References

'h _1.5'_1'9“

Document |Adter Text

Oplionsl Exit IHelp
[Seq [Type
Introdug | 11 Publications

Operotional Forces Supply Procedurms, NAVE

1.6.2.4.1.2 Add Equipment to a TG Sheet
To add equipment to a TG sheet:

1. Select Contents = Equipment.
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2.

Equipment

Intrarchug

References

Self-Test Questions
Safety Precautions

Job Steps
Answer

* Fealds ara required

If needed, select Resources = [type of resource] to choose a type of resource other than

Equipment.

B3 Job Sheet Equipment Selection

Sel

=
>riz

Options | Resources | Exit  Help

Calibration
Computers

Lonsumabies

<

Equipment

liiﬂﬂﬂ“ﬂi:‘ﬁﬁlﬁl

— e

Equipment Refurbished
Hand Tools
Maintenance Trainers
Miscallaneous M

Ordnance
Prefaulted
Software

Special Tooks
Support Equipment
Test Equipment
Training Devices
Training Equipment
Training Materials
V1 Equipment

3. Double-click the appropriate equipment. An X shows in the Sel column when selected.
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L

|

[ Job Sheet Equipment Selection

Options Resources Exit Help

Sel |Nomenclature

Part Number

AN/SIA-T1 Announcing System Tr

[ I»

X |AN/SIA-T1 Announcing System Tr

Aneroid Barometer

Desktop Simulation

ML-448/UM

X Communication System Training 5

Electric Psychrometer

IC/SM-T1 Alarm Training Set

Instructor Workstation (Deleted)™

Maneuvering Board

Red and black pens

Sling Psychrometer

Technical Training Equipment (TT

Trainee Workstation (Deleted)”

True Wind Computer

a

4. Repeat the above steps as necessary to add all equipment.

Note: If the equipment is not listed, add it to the RRL. Refer to Section 1.6.1.1 Adding ltems to Site
Resource Requirements List (RRL) for further instructions.

5. Select Exit to close the Equipment Selection pop-up.

=
3 Job Sheet Equipment Selection

Options Resources | Exit Help

Sel |Nc

Part Number

AN/SIA-T1 Announcing System T

X |AN/SIA-T1 Announcing System Tr

Aneroid Barometer

Desktop Simulation

ML-448/UM

% Communication System Traimng S

Electric Psychrometer

IC/SM-T1 Alarm Training Set

Instructor Workstation (Deleted)”

Maneuvering Board

Red and black pens

Sling Psychrometer

‘Technical Training Equipment (TT

Trainee Workstation (Deleted)*

True Wind Computer

L -

1.6.2.4.1.3 Add Study Assignments to a TG Sheet
To add study assignments to a TG sheet:

1. Select Contents = Study Assignments.

Page 118 of 171



Content Build and Migration in Support of Sailor 2025 SOP

21 December 2016

] l.mgnmms\‘:eé.:

Options [Contents] Exit Help

Study Assignments

Shootl
Study Questions
Answer

Intmoducion” |intraduction Required)

*Fitlds are required

2. Select Options > Add.

Add

X

u_.ShutMm ; ="
Exit_Hel :

Documant

Adter Text

Delete

View RRL

View IETM Stnscture

Launch/View [ETM

Select Reference for Document

Cetect IETM for Documeant

R N

3. When the number appears in the Seq. column, select Options = Select Reference for

Document.
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B Sheet References

B _IF

Options | Exit Hglp-

Add

Docurment

bl = e

After Text_

Select Reference for Document

Serect IETH 1oF Docament

4. When the Select Site RRL pop-up appears, double-click the appropriate document.

3 Select Site RRL

o 5 S

Options Select Exit Help

Find: IcEnlar search criteria here»

Find All

Document Title D Numb:
[Refri Monitor, Parase 59514-FL-MMA-010
Religious Ministry Team Handbook MCRP B-12A
Religious Affairs in Joint Operations Joint Pub 1-05
Religious Lay Leaders Handbook MCRP 6-12B

Religious Ministries in the Fleet Marine Fr

FMFM 3-6

Religious Ministry in the Fleet

NWP 1-05

Religious Ministry in the Navy

OPNAVINST 1730.1 (Series)

R Ministry Lay Leader

NTRP 1-05.1

Religious Ministry Support in the US Mari
Religious Ministry Support Within the DO

Religious Ministry Team (RMT) Training «

MCWP 6-12
SECNAVINST 1730.7D
MCO P3500.44A

UUOOOOOOOUOO%

1 Religious Ministry within the Department ([ SECNAVINST 1730.7 (Series)

Note: If the Study Assignment listed in the As-Is TG sheet does not have an actually publication
referenced that can be added to the RRL, the Study Assignment cannot be added to this Section.
Instead, add the Study Assignment to the Study Questions Section of the TG sheet. Prior to entering the

Study Questions, enter the following text:

Before answering the following questions, [insert study assignment text].

For example, “Study class notes” cannot be entered into Study Assignments because there is no
document to select. Therefore, the Study Assignment is entered into the Study Questions Section as:

Before answering the following questions, study class notes.

5. Repeat Steps 6-8 as needed to add all references.
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User Tip: Select the references in alphabetical order by title, as references cannot be
resequenced once they have been added to a TG sheet.

6. Select Exit to close the Sheet References pop-up.

B AANMELN  CATL . TR I
Shaet] B3 Sheet References : [P
| ODtiortsHeCu |

Seg. [Type [Documant [Adter Taxt_ ]

introdud | 1 Publications Operational Forces Supply Proceduron. NAVE |

*Fields

1.6.2.4.1.4 Add Additional Content to a TG Sheet
Other fields in the Contents drop-down menu are Microsoft® Word based, and are entered directly into
a Microsoft® Word document.

Follow these guidelines for all TG sheets:

e |f afieldis blank in the As-Is content, leave it blank in the new TG too.

e Format text as it appears in the As-Is content (i.e., bold, underline, italicize).

e When using bullets, use the default bullet settings in Microsoft® Word. Ensure the bullet levels
are consistent and reasonable among the TG sheets and that they do not start before 0.3”
indent.

e Use Notepad to copy and paste text. This helps avoid formatting issues and on-going auto-
numbering amongst multiple sheets.

o If the As-Is TG sheet contains lines to write an answer, do not include the lines. Simply enter
down to allow space for the trainee to write.

e Create tables as closely as possible to the way they appear in the As-Is content. Ensure the table

is within 6.5”.
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— i -
\\Nttlsrv03\Projects\NETC_Projed ~ | ¥ " ! Table Tools Co
| -

Home Insert Page Layout References Mailings Review View Developer Design

W Select~ [E, ﬁ ﬂ L@

£ View Gridlines
Delete = Insert Insert Insert Insert
x Above Below Left Right

Rows & Columns a
[1] 1...,...%...:.(5‘“.... . _ ‘
various fields that V] Preferred width:  6.5" [+ Measurein: EE_
list of instruction s| | “RIgRment
EH

[ cowmn | cel [ atText |

H Indent from left:

E

Sheet Contents

IRCITTTITI sectionOu

Gls1iGL Y References
Informati

Diagram

Problem

Problem
Answer

Job

Self-Test
Questions

'l E 7 HAE R R

e Ensure the font for TG sheets is Times New Roman, 12 point.
e Titles such as the following example can be entered with a larger, bold, centered font.

C. INFORMATION

Technical Research Unit

Processing Requests

e Ensure all TGs use the default indentations and spacing.
0 Check the spacing and indentation by right clicking and selecting Paragraph
= Before 0 pt.
= After 0 pt.
= Single line spacing
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= Left0.3”
*  Right 0.0”
rF'aragrapl'l ) m1
Indents and Spacing |Lnedeag=Breaks i
General

Alignment: Centered E]
Qutine level: | Body Text IE]

Indentation
Left: 03] specal: By:
Right: 0" - (none) E =

i [ Mirror indents

Spacing
Before: opt = Line spacing: At:
After: opt & Single E|

|"| Don't add space between paragraphs of the same style

Praview

bty et bih

'[ Tebs.. | [Setaspefait| [ ok | [ cancel ]

Note: You may need to select text and force this indentation. Preview the TG sheet once complete to
make sure all text aligns.

1.6.2.4.2 Add Media to a TG Sheet
To add media to a TG sheet:

1. Open the Word authoring Section of the TG sheet requiring a graphic.
2. Position cursor. Place the cursor in the position the graphic is needed.
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“ Home Insert Page Layout References Mailings Review View Add-Ins

=

i Times NewRom - 12~ A" 4" | Aav | B IE-UE-NE (S M T gappca AaBbC |AsBbCcl| AaBbCel AaBbCcI AaBb( AaBbCA AaBHCcl Ad
Pﬂ_ﬂf ",me canter B £ U - oahe x, x w7 - A - !E EEEE  H-E- Emphasis  Headingl | U MNormal Strong Subtitie Title T No Spaci... Subtle Em.. Int
Clipboard ) Font . Paragraph . Styles
The Coordi H itarian M Deliveries process is shown below:

Family member contacts AMCROSS.
A family member contacts the local AMCROSS chapter to request the relay of an emergent family
issue to a service member.

AMCROSS verifies information and sends AMCROSS message.

AMCROSS verifies the information by checking with local hospitals, doctor’s offices. or funeral
homes, and sends an AMCROSS message through official telecommunication means to the unit
communications office.

Note: Ensure the graphic is indented 0.3 from the left. Select Page Layout = Indent Left, and enter 0.3”.

3. Select the Add-Ins tab. You must use the “Add-Ins” tab to insert graphics. Do NOT use the Insert
tab. Do NOT paste the graphic directly into the sheet.

m Home Insert Page Layout References Mailings Review View Developer

\ Insert AIM Graphic \ Insert AIM Graphic
B Insert AIM IMM B Insert AIM IMM

Menu Commands Toolbar Commands

4. Select Insert AIM Graphic. You can select Insert AIM Graphic from either Menu Commands or
Toolbar Commands. They both result in the same outcome.

Home Insert Page Layout References Mailings Review View Developer Add-Ins

\. Insert AIM Graphic \. Insert AIM Graphic
B Insert AIM IMM B Insert AIM IMM

Menu Commands Toolbar Commands

5. Select the media file name.
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The Coordinate Humanitarian Message Deliveries process is shown below:

Family i3 Graphics o s S =&

Options £dt Exit Help t family
01_01_Diag_FO3 Assessment 6.50 8507 Fonersl
01_01_ES001218_Add_Neg_Num_Ans 650 362 :
01_01_InfoSheetz1_reqtime .50 1% | ||the unit
01_02_1G_cecularpolarization 250 150
01_02_TG_elippolarization 1,50 250
01 02 TG_emspectium 550 2%
01_02_TG_emspectum_2 B6.50 236
01_02_TG_inpolarization 150 250 | [P by
01_02_TG_rudpol 150 250
01_02_1G_speednange 450 369
01_03_1G_RF Wave_FM_Mods 542 33
01_03.16_RF_ Wave_AM_Mod 542 K&
01_03_1G_RF_Wave_KWL_CHART 6.50 350
01_03_TG_RF_Wave_Practice_Mods 1200 675
01_03_1G_fipacticemalching 550 850 +

i
5 = o dataui mml_ mwl_ it roster.

s0 it is

You can also select Options = Find to search for a graphic in the list. If you choose this option, be sure
to leave the asterisk at the end of the search field. Place your cursor before the asterisk and begin
typing. The list will update automatically.

Find Graphic:  |psa_0%

Graphic Description a
psa_09_01_01_d5_01process

psa_09_01_01_i4_00info —
psa_09 01_01_i4_07required

psa_039_01_01_i4_02submit_only_if

6. Select the Edit menu item - Save. The graphic will display in the TG sheet.
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The C

e H ool .

A famil
issu

AMH
AMC
homes,
comm

Unit C;
The uni
comm.

RP p:
Process

Lo
AM
The
im|

ge Deliveries process is shown below:

Family &) Graphics S

Options "
Save
Cancel

Exit Help

Assessment

Widh

01_01_ESD01218 N
01_00_InfoShest2] _fieqtime

28D

HF Wave FM_Mods

AF_Wave AM_Mod

AF Wave_lWL_CHART

-_Wave_Practice_Mods 12

Print with [F 50

1.6.2.4.3 Delete a TG Sheet

To delete a TG sheet from a Section, you must first delete all instances of the sheet throughout the

Section RIA.

1. Select the Element to which the TG sheet is attached.

2. Select the RIAs tab.

EEREEEEE

. Material Procure...

2. Safety Infor...

3. Introduction...
4. Introductio...
5. Requisitio...
6. Basic Fina...

Page 126 of 171



Content Build and Migration in Support of Sailor 2025 SOP 21 December 2016

Element | RlAs (15) Metadata

Source

Type | Text 4
Free Text Establish Contact.

Free Text Introduce yourself and give any background onyourself that might be of interest.

Free Text Establish Readiness.

Publication Feference: Naval Supply Procedures Manual, NAYSUP P-485.

Publication Reference: Logistics Specialist Supply Fundamentals, NAVEDTRA 15004,
Publication Reference: MILSTRIP Instruction, NAVSUFINST 4235.2.

Publication Reference: Uniform Material Movement and Issue Priority, OPNAVINST 4614.1F.

m

Free Text Motivating Statements:

Free Text Telltrainees how they will use the course material.

Free Text Tell trainees why they need to know the lesson material, il
Free Text Safety.

Student Sheet  Direct trainee to Material Procurement Material Procurement.

Fraa Tawvt Farh trainaa chrnld ravdaw tha Accianmant Shaat rnnr o stadinn the Tanie anc than v by

3. Select the appropriate sheet.

Type I Text I a
Publication Reference: Nawal Supply Procedures Manual, NAVSUP P-485.

Publication Reference: Logistics Specialist Supply Fundamentals, NAVEDTRA 15004,
Publication Reference: MILSTRIP Instruction, NAVSUPINST 4235.2.

Publication Reference: Uniform Material Movement and Issue Priority, OPNAVINST 4614.1F,

Free Text Motivating Statements:

Free Text Tell trainees how they will use the course material.

Free Text Tell trainees why they need to know the lesson material. =
Free Text Safety.

Student Sheet  Directtrainee to Material Procurement, Material Procurement.

Free Text Each trainee should review the Assignment Sheet prior to starting the Topic and thenr...
Free Text This Assignment Sheet will serve as notes for the Topic.

IMM Directtrainee to Material Procurement, CSS-LSA-060, on the Enterprise Training Mana... -

4. Select Resources = Delete Resource.
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[Resources | Contents Edit Exit
Add Resource
Add Graphic
Add Sheet
Add Fault
Add Free Text

TN b |

= i1 L

Delete Resource

Copy Resource

Paste Resource

View IETM Structure
Launch/View IETM
View RRL

Display Media
Modify/View Fault

5. Select the Yes button.

Learning Object Module v5.0

el

Yes

Are you sure you want to remove the selected resource from the
Element?

No

6. Repeat the above steps for all instances of the TG sheet.
7. Select the Save icon.

{esources

8. Select the Section folder that the sheet is in.
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Logistics Specialist (LS) - Block 0
Logistics Specialist (LS) - Block 1
Modules
[=}- (3 1. Aviation
. [Z} Lessons
(=} (33 1. Aviation Support Division ...
[+ Overview
[=}- Sections
=8 1.Aviation Support...
~ [# Summary
; [+- (3 2. Naval Tactical Command...
[+- (3 2. Postal Clerk
Religious Program Specialist (RP) - Core - BI...
Religious Program Specialist (RP) - Expediti...
Religious Program Specialist (RP) - Sea - Bl...
Religious Program Specialist (RP) - Shore - ...

Title
0
&

025

BEEE

9. Select the Sheets tab.

General | Job | JDTA | Info | Sheets | Resources | Metadata |

10. Select the TG sheet you wish to delete.

Source

Number | Type I Title

1 Assignment  Aviation Support Division (ASD)

2 Information SECTIONS OF THE AVIATION SUPPORT DIVISION

3 Information PROCESSING REQUISITIONS

4 Information PROCESSING REQUESTS

5 Information PROCESSING REQUESTS FOR CONSUMABLES/REPAIRABLES
B Information FUNCTIONS OF THE LOGISTICS SPECIALIST

7 Information DOCUMENT CONTROL UNIT ACTIONS

8 Information ISSUE PROCEDURES (MANUAL/AUTOMATED)

9 Information ISSUING MATERIAL

10 Information PROCESSING RFI/PROCESSING PART FROM IMA

11 Information AVIATION SUPPORT DIVSION GLOSSARY OF TERMS/ACRONY...

11. Select Sheets = Delete Sheet.
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[Sheets | Contents Edit

| AddSheet >

1| Delete Sheet |
Copy Sheet

ﬁ Paste Sheet

12. Select the Yes button.

Learning Object Module v5.0 ———

Are you sure you want to delete the selected Student Sheet from the
Section?

Yes No
¥ |
13. Select the Save icon.
{esources
1.6.2.4.4 Copy and Paste a TG Sheet
To copy and paste and TG sheet:
1. Select the Section that contains the desired TG sheet.
L+ Uveriew
[-]- Sections
-] 8 1 I

1. Section Introduction
2. The Navy SOH Program
= 3. Afloat Safety Guidelines
a. The afloat safety guidelines p
[ [k _Canacal Laflaat_cafatie auidalin

2. Select the Sheets tab, and then select the sheet to copy.
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g General | JOTA | Info | Sheets | Resources | Metedata |

Source

MNumber i Type | Title

1 Problem Activity

2 Outline Afloat Safety

3 Information Glossa

4 Information The Nawy SOH Frogram

5 Information Afloat Safety Guidelines

6 Information Safety Color Codes and Signs for Marking Phiysical Hazards
7 Problem Safety Color Codes Activity
] Information Personal Responsibilities
9 Problem Afloat Safety Practice

10 Diagram Average Diagram Sheet

1 Job Space Safety

12 Assignment Afloat Safety

3. Select Sheets = Copy Sheet.

le  Options Resmn-ces|5heets!tuntents Edit Exit Heip

| 8] @] Dol

3Wjm|m| | W T AddSheet b
Delete Sheet
i Copy Sheet
L5 A-233-0289 Electro Paste Sheet

™ AIM LOM Employ

pmentals

[=] Modules
LlOR 4 pecs ETEC A School Sandha

4. Select the sheet before which the copied sheet should be inserted.

\(En‘et search criteria here> Find | Clear |

General | Job | JOTA | Info | Sheets | Resources | Metadata |

Source

Number [ Type | Title

1 Problem Activity

2 Qutling Afloat Satety

3 Information Glossary

4 Information The Nawy SOH Program
5 Information Afloat Safety Guidelines
[ Informatian Safety Color Codes and Signs for Marking Physical Hazards
7 Problem Safety Color Codes Act

8 Information Personal Responsibilities
9 Problem Afloat Satety Practice

10 Diagram Average Diagram Sheet
n Job Space Safety

12 Assignment Afloat Safety

User Tip: Sheets can be pasted within a Section or to a different Section or Lesson.

5. Select Sheets = Paste Sheet.
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‘ile Options Resources m Contents Eclit  Exit Help

GRmE| B [t AddSheer v B @] DlEls] Bx] stk B-] 9
Delate Sheet
Copy Sheet | Version | States - Gane
[+] £ A-233.0289 Elect Pacte Sheet mientals 1 ]
=] '._ AW LOM Emgploy 1 1
-] Medules
[= : 1. CSCS ETIFC A Schoal Sandbox 1 i Sour

6. Double-click on the pasted sheet to edit as needed.

P T i

3 General | Job | JOTA | Info | Sheets | Resouwrces | Metadata |
Source
MNumber | Type I Title
Problem Adtivity
2 Outline Afloat Safety
3 Infarmatian Glossary
4 Information The Nawvy SOH Program
5 Information Afloat Safety Guidelines
B Information Safety Color Codes and Signs for Marking Physical Hazards
7 Problem Safety Color Codes Activi
9 Information Personal Responsibiliies
10 Problem Afloat Safety Practice
11 Diagram Average Diagram Sheet
12 Job Space Safety
13 Assignment Afloat Safety
7. Select the Save icon.
iesources

2| @]

1.6.2.4.5 Resequence TG Sheets
To resequence TG sheets:

1. Select the Section with the appropriate TG sheet.
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L+] Uverew
[-] Sections
[-] 8
1. Section Introduction
2. The Navy SOH Program
(-] [ 3.Afloat Safety Guidelines

a. The afloat safety guidelines p
[o] N h Ganaral aflaat cafati auidali

2. Select the Sheets tab and select the sheet to move.

General | Job | JDTA | Info | Sheets

Resources | Metadata |

Source

Number ‘ Type i Tille

1 Prablem Activity

2 COutline Afloat Safety

3 Information Glossary

4 Information The Nawy SOH Program

5 Information Afloat Safety Guidelines

B Information Safety Color Codes and Signs for Marking Physical Hazards
7 Problem Safety Color Codes Activi

8 Information The Nawvy SOH Frogram Part 2

9 Information

10 Froblem Afloat Safety Practice

1" Diagram Awverage Diagram Shest
12 Job Space Safety

13 Assignment Afloat Safety

Personal Responsibiliies

3. Dragthe sheet to the new location in the sheet sequence list.

General | Job | JOTA | Info | Sheets | Resources | Metacata

Source
Nurnber | Tvpe | Title |
1 Problem Activity
2 Outline Afloat Safety
3 Infarmation
4 Information
B: Information The Naw SOH Program Part 2
B Information Afloat Safety Guidelines
ki Information Safety Color Codes and Signs for Marking Physical Hazards
& Problem Safety Color Codes Adtivity
q Information Personal Responsibiliies
10 Prablem Afloat Safety Practice
11 Diagram Awverage Diagram Sheet
12 Job Space Safety
13 Assignment Afloat Safety
4. Select the Save icon.
iesources

2| @ =
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1.7 Update Course in LO Module from CPM

Prior to exporting the LP and TG for delivery to the Learning Center, LO Module should be updated to
reflect the addition of the Objectives and Module changes. The Course should be exported to the EDE
from CPM and then updated in LO Module from the EDE. Once this update is complete, the Course
should be reviewed to ensure there are no errors.

1.8 Exporting LP and TG for Review
The LP and TG are exported as PDFs from AIM LO Module. Exports take place prior to Learning Center
review.

the LP and TG are exported at the Course level and delivered for the entire Rating.

1.8.1 Generating an LP

AIM LO Module generates an LP using all the information entered within the Element and RIAs tabs.
Once generated, the LP is saved as a PDF file. For this project, LPs will be exported at the Course level for
Learning Center review.

User Tip: Save often and be patient when in AIM LO MODULE. AIM LO MODULE quite often
takes a few moments to update.

Note: The following instructions describe how to export the LP at the Course level, however exports can
be done at the Module, Lesson, or Section level for internal reviewing and QA’ing.

1. Select the Course title from the Course structure.

File Options Resources Contents Edit Exit Help

% o[ )] ®| W talo| ] Ao
Title \
ERE] Sonar Technician (Submarine) (STS)

+}- ) Sonar Technician (Surface) (STG)

2. From the Preview drop-down menu, select LP.
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[@ 5] Bl x| 48[t

Course I Objectives LP Change Package
Title s
— TG Change Package
ISunarTechnlcmn (Subr
TPP from EDE
TCCD from EDE

Yersion |1

(& : g"(Enter search critel
LP

Status™IReomplete ¥

Version Change |None

=l

3. On the Printer Setup pop-up, select the OK button.

I~ Print'Page X of Y*

Setup Header/Footer I

~Course Matter ltems

¥ Front Matter
v Content
¥ Reference Materials (Back Matter)

4, Use the Print Preview

[T Exclude Self-Paced Sections

~Main DP Printing Options
" DP perPage
@ Continuously

~DP Spacing
Number of blank lines between | 1
F"g%l’n’t‘:e specimea U

Lracina

to preview, search, etc.

5. To save the LP PDF, select File = Save As...
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78 Edit View Window Help
% Open... Ctrl+0

Open From Acrobat.com...

W e—]

T2 Create PDF Online...

[=) save Ctrl+S
Save As... Shift+Ctrl+S
Save As Other... 4
Save To Acrobat.com...

6. Save to the appropriate folder, using the required naming convention.
a. File name for deliveries to the Learning Center should be entered as

[Rating]_LP_MMDDYYYY.

7. Select Exit to close the Print Preview window.

1.8.2 Generating a TG

User Tip: Save often and be patient when in AIM LO MODULE. AIM LO MODULE quite often
takes a few moments to update.

Note: The following instructions describe how to export the TG at the Course level, however exports can
be done at the Module, Lesson, or Section level for internal reviewing and QA’ing.

1. Select the Course title from the Course structure.

r’A

File Options Resources Contents Edit Exit Help
[ [ @] @ & e il

j [T _
El'iﬂ Sonar Technician (Submarine) (STS
“ ) £ Sonar Technician (Surface) (STG)

2. From the Preview drop-down menu, select TG.
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‘_&m g"(Enter search criterie

LP L
d¢

LP Change Package
TG
— TG Change Package

TPP from EDE
TCCD from EDE
tatrs™ TIncomplete od

Note: When Print Previewing a TG Sheet from other levels in the Course structure, the Print
Preview drop-down may say Sheet instead of TG.

User Tip: Be patient when the Preparing pop-up appears. AIM LO MODULE may take several
minutes to create the TG sheet preview.

3. Once the Word Lesson Sheets preview appears, select File = Save As to save the TG sheet.

.i- Print Preview
= save

L save As
|7 Open

[_‘j' Close

4. Select PDF from the Save as type drop-down menu.

File name: Lesson Sheets -

Save as type: IWotd QTf% D%ﬂﬂt v,l

Authors: Word Document

Word Macro-Enabled Document
Word 97-2003 Document

Word Template

Word Macro-Enabled Template

Word 97-2003 Template
ide Folders _

XPS Document
P Single File Web Page
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Note: You must save the TG as a PDF. Information will not display if saved as a Word document.

5. Save to the appropriate folder, using the required naming convention.
a. File name for deliveries to the Learning Center should be entered as

[Rating]_TG_MMDDYYYY.

User Tip: The PDF version often appears differently from the Print Preview version. When
checking the Lesson for formatting issues, check the saved PDF, not the Print Preview.

6. Select the Close Print Preview button to close the print preview.

o | Show Ruler A ETErre A
Mexd Page

| Magnifier

o - ‘B Previous § ¢ iose Pt
h 2y shink One Page Prnew

JE

OUTLINE SHEET 1-1

2 Learning Center Review of Performance-Based Course Structure and
Gaps

The Rating LP and TG are reviewed by the Learning Center to ensure all content is accurately reflected

within the Performance-Based Course Structure from the content migration. The Learning Center also

reviews the Courseware for any missing content that was identified through the content migration from

the previous versions of AIM to AIM CPM/LO Module and provides recommendations for filling in

content.

A standard comment and adjudication spreadsheet is used to track Learning Center review comments
and recommendations. The Learning Center reviewers enter their name, the location of the comment
(or Global if it refers to the entire Course), and their specific comment or recommendation remarks in
the Performance-Based Course Review tab of the comment spreadsheet. The Learning Center should
also provide specific text to enter for any areas in the LP or TG that have [Content not available] or
[Reference not available].
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A B Cc D
[Rating] Reviewer Comments
Reviewer het Location Comment b Contractor Adjudication b
Sample Reviewer Global Add (Series) to publication numbers.
Lesson Plan Add RIA to each element to change the

Sample Reviewer

Module 2, Lesson 3, Section 4

PowerPoint slide.

Sample Reviewer

Lesson Plan
Military Postal Service (MPS)
Section, Introduction Element

Add RIA to this element to direct trainees to
the Outline Sheet.

Sample Reviewer

Trainee Guide
Outline Sheet 3-2-1-1
Introduction section

Replace [Content not available] with the
following text: The purpose of this outline
sheet is to provide an overview of the topics
covered in this section and a place to write
notes.

This spreadsheet is sent back to the Lead ISD at the completion of the review.

Double-click the file below to open the Learning Center Comment Template

Center_comments_te

3

Learning

Implementation of Learning Center Recommendations
Once the Learning Center review comments are received, comments are implemented in LO Module

and recommended content for areas that indicate [Content not available] is entered. All comments and

recommendations are implemented in CPM/LO Module and adjudicated in the comment spreadsheet.

1

3

<

6

A B C D
[Rating] Reviewer Comments
Reviewer v Location Comment v Contractor Adjudication b

(Series) added to the end of the Document Number for

Sample Reviewer Global Add (Series) to publication numbers. each publication within the Rating. BA 12/08/2016
Added the following RIA to the end of each element
Lesson Plan Add RIA to each element to change the within the Section: "Advance to the next slide.” BA

Sample Reviewer

Module 2, Lesson 3, Section 4

PowerPoint slide.

12/08/2016

Sample Reviewer

Lesson Plan
Military Postal Service (MPS)
Section, Introduction Element

Add RIA to this element to direct trainees to
the Outline Sheet.

The following RIA was added to the Introduction
Element: "Refer trainees to Outline Sheet 3-2-1-1,
Military Postal Service (MPS)." BA 12/08/2016

Trainee Guide
Outline Sheet 3-2-1-1

Introduction section

Replace [Content not available] with the
following text: The purpose of this outline
sheet is to provide an overview of the topics
covered in this section and a place to write

notes.

Replaced [Content not available] with suggested text as
requested. BA 12/08/2016

Sample Reviewer
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4 Learning Center Verification of Course Content
Prior to creating the Block Courses, the Learning Center performs another review and verification of the
Course content that was filled into all of the [Content not available] items.

The Learning Center reviewers will verify the adjudication and make additional comments in the
Verification column.

Comment v Contractor Adjudication v Verification v
(Series) added to the end of the Document Number for
Add (Series) to publication numbers. each publication within the Rating. BA 12/08/2016 Implemented SR12/20/16
Added the following RIA to the end of each element
Add RIA to each element to change the within the Section: "Advance to the next slide.” BA
PowerPoint slide. 12/08/2016 Implemented SR12/20/16
Add RIA to this element to direct trainees to |{The following RIA was added to the Introduction
the Outline Sheet. Element: "Refer trainees to Outline Sheet 3-2-1-1,
Military Postal Service (MPS)." BA 12/08/2016 Implemented SR12/20/16
Replace [Content not available] with the
following text: The purpose of this outline
sheet is to provide an overview of the topics Implemented, however space needs to be added
covered in this section and a place to write  {Replaced [Content not available] with suggested text as |between each paragraph in the Outline Sheet to
notes. requested. BA 12/08/2016 accommodate notes. SR 12/20/16

5 Block Course Development
Once the Learning Center verification review comments are received, comments are implemented in LO
Module. At this time, the Block Courses can be created in CPM with the appropriate content linked.

5.1 Create Block Courses in CPM
The approved Block Learning Recommendations Report is used to update CPM with the Block Courses.
Block Courses are created in CPM for each Block within each Training Path for the Rating.

Instructions TBD based on software functionality updates.

5.2 Link Appropriate Content to Block Courses in CPM
The approved Block Learning Recommendations Report to is used to link appropriate Lessons and
Sections from the Rating Project to the Block Courses in CPM.

Instructions TBD based on software functionality updates.

5.3 Create TPP/TCCD in CPM
2. TCCD/TPP
a. Forward
i. Course Mission Statement — business rule — should be included in the CeTARS
description in the Course Overview (NAVEDTRA 131 2-10)
ii. Forward - Rewrite to provide brief history; some could be cookie-cutter list ->
create this list
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b. Course Overview — Rewrite the Fleet requirements for the Course from the original
(NAVEDTRA 130 & 131) .

i. A Course Overview should be included in CeTARS Course Overview Screen;
provides topical outline of the Course

c. Development Method

i. Documents Section — select boxes TPP, TCCD, TG, IMM, Support Materials, LP,
Knowledge/ Performance Test and Administrator’s Guide, Testing Plan
ii. Learning Objects: select appropriate item (write business rules)
d. Trainee Data
e. Justification - tailored statement reflective of Sailor 2025
i. Reference(s)— Use “Based on Sailor 2025 Directives”
ii. Reasons for and Anticipated Benefits of the Proposed Project - leave blank for
Sailor 2025
iii. Summary of Differences - leave blank for Sailor 2025
iv. Impact If Not Approved - leave blank for Sailor 2025

f. Milestones — leave blank for Sailor 2025

g. Safety Risks and Hazardous Materials — select appropriate items and provide text for
specific requirements

h. Purpose of Course — Rewrite the purpose of the Course (should match with CeTARS)
NAVEDTRA 130 & 131 does not have this; should this be dropped from AIM/CPM?

i. Pre-requisites — requirements for the Course or Rate (i.e., ASVAB scores) if an initial
Course of instruction (split out from Pre-requisites/Occupational Classification if an
existing TCCD)

j. Occupational Classification - This Course provides the student with the occupational
Rating of XXX upon successful completion (split out from Pre-requisites/Occupational
Classification if an existing TCCD)

k. Instructor/Support Manning — (located in TPP; if missing contact Learning Center (LC))

I.  Training Sites — created in Admin tab of CPM and marked active

i. Goto Admin tab in CPM
ii. Goto Centers—ensure center is marked “Is Active”
iii. Go to Training Sites — if not listed, select “New” and use Business Rule — write
exactly the way CeTARS lists the site name and information
iv. Go back to Project Tab
v. Highlight “Training Sites” and select “New” then select appropriate site data and
save
vi. CMS — Master Schedule Summary Sheet is TTCCD (Keep learning hierarchy
intact, include instructor ratios, need Business Rules for entire Section)
1. Justification — why differing from CCMM for a training site?
vii. Facilities — How much money and facilities requirements to complete Course
(needs Business Rules)
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viii. Funding — From existing TCCD; include accounting lines for all items (need
Business Rule if it doesn’t exist)
ix. Manpower - From existing TCCD; include for all required out years (need
Business Rule if it doesn’t exist)
X. RRL—From existing TCCD (needs Business Rules)

5.4 Update LO Module with Block Courses
Instructional Developer updates LO Module with new Block Courses and reviews for any necessary
modifications.

Instructions TBD based on software functionality updates.

6 Learning Center Review of New Block Courseware

Once the Block Learning Courses are created, the LP, TG, and TCCD for each Course is exported and
delivered to the Learning Center in PDF format. The Learning Center reviews the Block Courses for any
final adjustments that need to be made to the Courses.

The Learning Center receives the comment and adjudication spreadsheet along with the Courseware.
The Learning Center reviewers enter their name, the location of the comment (or Global if it refers to
the entire Course), and their specific comment or recommendation remarks in the Blocked Course
Review tab of the comment spreadsheet.

The contractor will implement all comments and resubmit the Courseware to the Learning Center for
final approval before the Content Build Process is considered complete and the Course content is
imported into the Sailor 2025 instance of LO Module on the Citrix Servers.

7 Course Import into Citrix Servers
If the Courses were populated in a standalone instance of LO Module, they need to be imported into the
Sailor 2025 instance of LO Module on the Citrix Server.

7.1 Export SCORM Packages from Standalone LO Module
Lead ID exports SCORM package of Courses from Standalone LO Module.

To export a SCORM Package:

1. Select the appropriate Course at the Course level.
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3. Save the zipped file to the predetermined folder.
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3 Courses n| ol
File Options Resources Contents Edit Exit Help
(&5 Save SCORM Package ss. g » I T R e e—— L=} |
L @4 T ~[ %2 [ Search z017-0001 Soior 2025 P
Organize v MNew folder g= - o
). 2019-0019 Sailor *  pame Date modified Type Size |

. Z017-0001_Sailor

b AM
B Lifinsies . AIM_CPM_SOP
alj 5 - . Content Builds
+ Documents
L Imp
Musi
\£| p_::lc Ju Management
ictures
B Videos i MonthlyReports
1. RATS_SOP
Resources
1% Computer +
B Windows (C:)

¥ Files (\\NttiSnv03
¥ orlofcfiles (\\nttl:
L Projects (nttlsnv0.

-

11/30/2016 11:59 ...  File folder
12/8/2016 11:25 AM  File folder
11/30/2016 11:59 ...  File folder
12/1/2016 10:05 AM  File folder
11/30/2016 11:21 ...  File folder
12/6/2016 2:30 PM  File folder
12/8/2016 10:01 AM  File folder
11/30/201611:21 ...  File folder

* File name: Religious_Program_RP__A_ Course_2016__Ver 1 SCORM

Save as type: [ﬁp Files (*.zip)

'~ Hide Folders

Note: The file name autopopulates when saving the SCORM package.

7.2 Import SCORM Packages into Sailor 2025 Citrix Server
Lead ID imports SCORM package of Courses into Sailor 2025 instance of LO Module on the Citrix Server.

Instructions TBD.
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Appendix A: Completing the AIM CPM Data Tab

The Data tab allows users to enter data to support the building of information in AIM CPM. Data types
include the following:

e Platforms

e Systems

e Subsystems

e Components
e Non-Equipment
e Environments
e Tools

e Verbs

e Conditions

e Standards

e KSATRs

Platforms
1. From the Data submenu, select Platforms.

OCCSTDs JDTA Projects Reports Resources Admin

Platforms [Eystems Subsystems Comp Mon-Equipment Environments Tools Verbs Conditions Standards KSATRs

2. Select the New icon.

m Data OCCSTDs JDTA Projects

Platforms Systems Subsystems Components Non-Equipment Envirol
Platforms New 1|8 & @ X

Title

Internal

Library

3. Inthe Title* field, type in the platform title.

i Conditions Standards KSATRS

* incicaten o reguired fald.
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User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
If the platform is a general term or phrase, enter it in sentence case. If the platformis a
formal name, enter it in title case.

Examples of platforms that currently exist in the Platform submenu include the following:

e All aircraft carriers

e All amphibious ships

e All auxiliary ships

e All aviation platforms

e All cruisers

e All destroyers

o All fixed-wing aircraft

o All platforms

e All rotary-wing aircraft

e All ship platforms

e All submarines

o Hawkeye (E-2) early warning and control aircraft
e Los Angeles (SSN-688) class submarine

e San Antonio (LPD-17) class amphibious ship
e Sea King (H-3) helicopter

4. Select the Save button.

i ik sweet et

i Conditions Standards KSATRs

s [

= inclicater 8 reguired fiald.
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Systems

1. From the Data submenu, select Systems.

Data OCCSTDs JDTA Projects Reports Resources Admin

5 Components Non-Equipment Environments Tools Verbs Conditions Standards KSATRs

2. Select the New icon.

m (ST o0CCSTDs  JDTA  Projects  Re
Platforms Systems Subsystems Components Non-Equipment

Systems @ a8 ® %

3. Inthe Title* field, type in the new system title.

Admin Help Support Logout
¢ Conditicns Standards KSATRs

= indicates 2 required fiald.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
If the system is a general term or phrase, enter it in sentence case. If the system is a formal
name, enter it in title case.

Examples of systems that currently exist in the System submenu include the following:

e TBD
e TBD
e TBD
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4. Select the Save button.

e

Support  Logout
§ Conditions Standards KSATHS

Ced o

* indicates @ required fiald.

Subsystems

1. From the Data submenu, select Subsystems.

m Data OCCSTDs JDTA Projects Reports Resources Admin
Platforms Systems Components Non-Equipment Environments Tools Verbs Conditions Standards KSATRS

2. Select the New icon.

| Home BLETTWN oCCSTDs  IDTA  Projects  Re
Platforms Systems Subsystems Components Non-Equipment

Subsystems 9 & & X

3. Inthe Title* field, type in the new subsystem title.

Help Support Logout
i Conditions Standards KSATRS

= inclicates a requined fiald.
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User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
If the subsystem is a general term or phrase, enter it in sentence case. If the subsystem is a
formal name, enter it in title case.

Examples of subsystems that currently exist in the Subsystem submenu include the following:

e TBD
e TBD
e TBD

4. Select the Save button.

C=d o

* indcater 3 requined finld.

Components

1. From the Data submenu, select Components.

| Home QTTTW OCCSTDs  JDTA  Projects  Reports  Resources  Admin
Platforms Systems Subsystemns Non-Equipment Environments Tools Verbs Conditions Standards KSATRS

2. Select the New icon.

| Home QUFTTMN OCCSTDs  IDTA  Projects  Re
Platforms Systems Subsystems Components Non-Equipment

Components new |8 fu @ X

Page 149 of 171



Content Build and Migration in Support of Sailor 2025 SOP 21 December 2016

3. Inthe Title* field, type in the new component title.

e sopport_togo

i Conditicns Standards KSATRS

= indicates 3 reguined fald.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
If the component is a general term or phrase, enter it in sentence case. If the component is a
formal name, enter it in title case.

Examples of components that currently exist in the Components submenu include the following:

e TBD
e TBD
e TBD

4. Select the Save button.

(I

® inciated 8 required fiald.

Non-Equipment

1. From the Data submenu, select Non-Equipment.
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[ Home TN occsTDs  IDTA  Projects  Reports  Resources  Admin
Platforms Systems Subsystems Components |Non-Equipment | Environments Tools Verbs Conditions Standards KSATRs

2. Select the New icon.

OCCSTDs JDTA

| Home JLET Projects  Rej

Platforms Systems Subsystems Components MNon-Equipment

pen 0|® & @ %

Non-Equipment

3. Inthe Title* field, type in the new non-equipment title.

Admin Help: Support Logout
b Conditions Standards KSATRS

® indicates & required fiald.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
If the non-equipment is a general term or phrase, enter it in sentence case. If the non-
equipment is a formal name, enter it in title case.

Examples of non-equipment that currently exist in the Non-Equipment submenu include the following:

e TBD
e TBD
e TBD

4. Select the Save button.
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o Jher swwon  togem
P Conditions Standards KSATRS

® indicates 2 required fiald.

Environments

1. From the Data submenu, select Environments.

JDTA

m Data Projects Reports

Platforms Systems Subsystems Components Nm—Eqqumant

Admin

2. Select the New icon.

m TrW OCCSTDs  IDTA  Projects

Reports
Platforms Systems Subsystems Components Non-Equipment Environments

Environments @ & ® x

3. Inthe Title* field, type in the new environment title.

Help Support Logout
i Conditicns Standards KSATRS

* inchcabed & required flald.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:

If the environment is a general term or phrase, enter it in sentence case. If the environment
is a formal name, enter it in title case.
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Examples of environments that currently exist in the Environments submenu include the following:

e TBD
e TBD
e TBD

4. Select the Save button.

-
= [ =

i Conditions Standards KSATRS

Ced e

* indicates a requined fiald.

Tools

1. From the Data submenu, select Tools.

m Data OCCSTDs JDTA Projects Reports Resources Admin
Platforms Systems Subsystems Components Mon-Equipment Environments | Tools |Verbs Conditions Standards KSATRs

2. Select the New icon.

Projects Reports

Tools new 1 @ & @ X

3. Inthe Title* field, type in the new tool title.
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e Tad swren o
i Conditions Standards KSATRs
Titla®:
[ save | cancel |

¥ inclcater & reguired fald.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:

If the tool is a general term or phrase, enter it in sentence case. If the tool is a formal name,
enter it in title case.

Examples of tools that currently exist in the Tools submenu include the following:

e TBD
e TBD
e TBD

4. Select the Save button.

-
T

i Conditions Standards KSATRS

el e

" indicaten o required fald.

Verbs

Verbs cannot be entered into AIM CPM. New verb suggestions can be made to NETC CPM Management,
and if approved, will be added the current list of verbs. Verbs appear in AIM CPM in alphabetical order
with their corresponding domain (cognitive, affective, and psychomotor) indicated.
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W owe

OCCSTDs

JDTA

Projects  Reports  Resources

Platforms Systems Subsystems Components Non-Equipment Environments Tools| Verbs

Verbs

Title
Abandaon
ABORT
ACCERT
ACCESS
Accessing
ACCLIMATIZE
ACCOMPLISH
ACCUMULATE

GRS
Cognitive  Affective  Psychomoter Al
* I

Admin

onditions Standards KSATRS

The current list of verbs is shown below with their corresponding domain indicated.

Title Cognitive Affective Psychomotor
Access X
Acquire X
Activate X X
Adjust X
Administer X
Advise X X
Aid X
Align X X
Analyze X
Annotate X
Apply X
Approve X
Archive X
Arm X
Arrange X X X
Articulate X X
Assemble X
Assess X X
Assign X
Assist X
Attach X X
Attend X
Audit X
Authorize X
Backup N/A N/A N/A
Bake X X X
Balance X X
Be X
Bend X
Blue X
Boil X X X
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Title Cognitive Affective Psychomotor
Braise X X X
Brief X
Broil X
Build X
Calculate X
Calibrate X
Call N/A N/A N/A
Carry X
Carve X
Certify X
Change X X
Characterize X
Check X
Chill X X X
Chock X
Classify X X
Clean X
Clear X X
Close X
Collate X
Collect X X
Combat X X
Communicate X
Compare X X
Compile X
Complete X X X
Comply X
Compose X
Compute X
Conduct X X
Configure X
Connect X
Construct X X
Contain X X X
Control X
Convert X
Coordinate X
Correct X X
Correlate X
Counsel X
Create X X
Cut X
Cycle X X
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Title

Cognitive

Affective

Psychomotor

Debrief

Decode

Deconflict

Decorate

Define

XX | X |[X

Delegate

Deliver

>

Demonstrate

Deploy

Deposit

De-rig

Describe

Design

>

Designate

>

Destroy

Detain

>

Detect

Determine

Develop

Dewater

XX [ X [X|X

Dial

Dig

Direct

Disassemble

XX | X|X[X

Disburse

Disconnect

Disintegrate

Dispatch

Dispose

Disseminate

Distribute

XXX |[X|[X]|X

Document

Doff

Don

Download

Draft

Draw

Dress

XX | X[ X|[X|X]|X]|X

Drill

Edit

>

Employ

Enable

N/A

N/A

N/A

Encode
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Title

Cognitive

Affective

Psychomotor

Endorse

Energize

Enforce

Engage

Enhance

N/A

N/A

Ensure

Enter

Equalize

Erect

Establish

Estimate

X | X | X |[X

Evacuate

Evaluate

Examine

Execute

Exercise

>

Explain

Exploit

Extract

XX |[X|[X|[X|X]|X

Fabricate

Facilitate

File

Fill

Finish

Fire

Fix

>

Follow

Forecast

Formulate

Forward

Fry

Gather

Generate

Give

Grant

N/A

N/A

Graph

Grill

Grind

Groom

Handle

Heat

Identify

>

Implement
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Title Cognitive Affective Psychomotor
Incorporate X X
Inform X
Initialize X
Initiate X X X
Input X
Insert X
Inspect X X
Install X
Instruct X
Integrate X X X
Interface X
Interpret X X
Interview X
Inventory X
Investigate X
Isolate X
Issue X
Know N/A N/A N/A
Label X X
Launch X
Lead X X
Liaise X
Lift X
List X
Load X
Localize X
Locate X
Log X
Lower X
Lubricate X
Machine X
Mail X
Manage X X
Manually X
Manufacture X X X
Map X X
Mark X
Match X
Measure X
Mentor X
Mix X
Modify X X X
Monitor X X

Page 159 of 171




Content Build and Migration in Support of Sailor 2025 SOP

21 December 2016

Title Cognitive Affective Psychomotor
Moor X
Move X
Navigate X
Notify X X
Observe X X
Obtain X X
Open X
Operate X X
Optimize N/A N/A N/A
Order X X X
Organize X X X
Outline X X
Overhaul X
Override N/A N/A N/A
Pack X
Package X
Paint X
Participate X X
Pass X
Perform X X X
Place X
Plan X
Plot X
Plug X
Portion X X X
Position X
Post X
Predict X
Preheat X X
Prepare X X
Present X
Preserve X
Print X
Prioritize X X
Process X X
Procure X
Produce X X
Program X X
Provide X X
Publish X
Purge N/A N/A N/A
Qualify X X
Raise X
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Title Cognitive Affective Psychomotor
React X
Read X X
Receive X X
Recertify X
Recharge X
Recognize X X
Recommend X
Reconcile X
Record X X
Recover X
Recruit X
Refer X
Refuel X
Refurbish X
Register N/A N/A N/A
Reinforce X
Relay X
Release X
Remove X
Render X
Repack X
Repair X
Replace X
Replenish X
Report X X
Represent X
Request X
Requisition X
Research N/A N/A N/A
Reset X
Resolve X
Respond X X X
Restore X X
Retain X
Retrieve X X
Return X
Review X X
Revise X X X
Rig X
Rotate X
Route X
Safeguard X
Sanitize X X X
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Title Cognitive Affective Psychomotor
Scan X X
Schedule X
Screen X
Search X
Secure X
Seek X
Select X X
Send X
Separate X X
Sequence X X
Serve X
Service X
Set X
Sharpen X
Shift X
Shut N/A N/A N/A
Signal X
Solicit X
Sort X
Sound X
Splice X
Split X
Stand X
Start X X
Startup X
State X
Steam X
Steer X
Stock X
Store X X
Stow X
Stream X
Stress X X
Submit X X
Summarize X
Supervise X X
Support X X X
Survey X
Suspend X
Synthesize X X
Take X
Test X X
Tie X X
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Title Cognitive Affective Psychomotor

Trace X X

Track

>

Train

Transcribe

Transfer

Transition

XX | X |X|[X
>

Translate

Transmit

Transport

Transpose

Treat

XX | X|X|[X

Troubleshoot X

Understand X

Unload

Unpack

Unrig

XX | X |X

Update X

Upload X

Use X X

>

Utilize X

Validate X X

Verify X X

Weld

>

Write X X X

Conditions

1. From the Data tab submenu, select Conditions.

| Home WLPTWN oCCSTDs  IDTA  Projects  Reports  Resources  Admin

Platforms Systems Subsystems Components Non-Equipment Environments Tools Verbs | Conditions | Standards KSATRs

2. Select the New icon.

m LTS occsTDs  JDTA Projects  Reports  Resources  Admin

Platforms Systems Subsystems Components Non-Equipment Environments Tools Verbs Conditions Standa

Conditions @ aex

Title
|Gisap_annlicahla documantation I

3. Inthe Title* field, type in the new condition.
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Tools Verbs Conditions Standards KSATRs _

Title*:

conce |

* indicates a required field.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.

Style Guide:
Enter the condition in sentence case.

Examples of conditions that currently exist in the Conditions submenu include the following:

Given applicable documentation and/or directives,

Given an applicable Maintenance Requirement Card (MRC),
Given applicable technical documentation,

Given the proper tools,

Given the proper tools and data,

Given the proper equipment,

Given the required information,

Sm o a0 T

Given applicable Operational Sequencing System (OSS) procedures,
Given applicable Operational Procedures (OPs),

j.  Given applicable Casualty Procedures (CPs),

Note: Never reference a specific equipment or reference in the condition. Conditions should remain
general in nature.

4. Select the Save button.
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Tools Verbs Conditions Standards KSATRs _

Title*:

conca

* indicates a required field.

Standards

1. From the Data submenu, select Standards.

m Data OCCSTDs JDTA Projects Reports Resources Admin
Platforms Systems Subsystems Components Non-Equipment Environments Tools Verbs Conditions SATRs

2. Select the New icon.

m Data OCCSTDs JDTA Projects Reports Resources Admin

Platforms Systems Subsystems Components MNon-Equipment Environments Tools Verbs Conditions Standards |

Standards INew hl@ & ® x

[Title

IAW applicable documents and directives

IAW DoD 4525.6 (Series); Domestic Mail Manual, USPS Publication; International...
TAW DoD Postal Manual, DoD 4525.6 (Series); Domestic Mail Manual, USPS Public...
IAW DoD Postal Manual, DoD 4525.6 (Series); Domestic Mail Manual, USPS Public...
IAW Domestic Mail Manual, USPS Publication; and Logistics Specialist Postal Fund...

3. Inthe Title* field, type in the new standard.

Tools Verbs Conditions Standards KSATRs

Title*:

Save Cancel I

* indicates a required field.

User Tip: CPM can have problems with formatted text that is copied and pasted into fields.
To avoid this, copy the text into Notepad, and then cut and paste the Notepad text into
CPM.
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Style Guide:
Enter the standard in lower case.

Examples of standards that currently exist in the Standards submenu include the following:

e TBD
e TBD
e TBD

Note: Never reference a specific equipment or reference in the standard. Standards should remain
general in nature.

4, Select the Save button.
Welo  suppert  Logout

tbs Conditions Standards KSATRs

Title*:

I Save || Cancel

* indicates a required field.

KSATRs

1. From the Data submenu, select KSATRS.

m Data OCCSTDS JDTA Projects Reports Resources Admin
Platforms Systems Subsystems Components Non-Equipment Environments Tools Verbs Conditions Standards| KSATRs

Knowledge new 3 @ & @ X

2. From the drop-down menu, select the type of KSATR to enter.
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m [T1eBll oOCCSTDs JDTA  Projects  Reports  Resources  Admin
Platforms Systems Subsystems Components MNon-Equipment Environments Tools Verbs Conditions Standards KSATRs

Knowledge new ) @ & & X

Skill

Title EJ
= Engineering Technolog ol

Hespurce
- Enaineering Technolod
"CG major and associated components by name, nomendlature, location, physical...

3. Select the New icon.

m Data OCCSTDS JDTA Projects Reports Resources
Platforms Systems Subsystems Components MNon-Equipment Environments Tools Verbs Conditions Standards KSATRS

Tool Tool W Ium ) p & ® %

4. Inthe Title* field, type in the new KSATR item title.

s [ ven spon togou

i Verbs Conditions Standards KSATRs

Tithe®: A
W
Type*: Tool
[[save | Cancel |
= indicates a required field.

5. Select the Save button.

R

i Werbs Conditions Standards KSATRs

Type*: Tool

e ] Cancel |

= indicates a required field.
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Appendix B: Transferring AIM LO Module Resources to AIM CPM
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